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Installation Overview 
 
The TIMY-Soft application is provided on the USB-Key shipped with the TIMY-System. Install 
the application on the PC before inserting the USB-Key into the TIMY Time Reporting 
Terminal.  
 
WARNING:   THE TIME REPORTING TERMINAL DELETES ALL THE APPLICATION FILES FROM 

THE USB-KEY WHEN THE KEY IS INSERTED INTO THE TERMINAL. 
 
TIMY-Soft consists of a collection of Microsoft® Excel files. The application runs under all 
versions of Microsoft® Excel starting with Excel 97. TIMY-Soft requires a PC with any of the 
following configurations: 
 
• Windows® 98 SR2 with Excel 97 (no other Excel versions are compatible) 
• Windows® XP with Excel 2000, Excel 2002, Excel 2003, Excel 2007 and Excel 2010 
• Windows® Vista with Excel 2007 (no other Excel versions are compatible) 
• Windows® 7 with Excel 2007, Excel 2010 or Excel 2013 
• Windows® 8 with Excel 2013 (no other Excel versions are compatible) 

 
The TIMY-Soft application does not run under: 
 
• Versions of Microsoft® Excel prior to Excel '97 
• Versions of Excel running on Apple® Mac computers 
• Other spreadsheet programmes such as Microsoft® Works, Apache OpenOffice™, etc. 

 
 
Verification of PC Calendar Settings 
 
Before starting with the installation procedure, check the Date and Time formats in the 
Control Panel of the PC (Regional Options). 
 
1) The Date Format must be set to "dd/mm/yyyy", that is "day" with two-digits, "month" 
with two digits and "year" with four digits. TIMY-Soft does not function with computers 
set to the American date format "mm/dd/yyyy". 
 
2) The Time Format must be set to "hh:mm:ss", with the ":" (colon) as separator. 
 
TIMY-Soft cannot function correctly if the Date and Time settings are not correct. 
 
 
Installing on a PC with Windows®98 
 
A USB driver must be installed before starting the installation process. This is available 
from the TIMY-System supplier on request. 
 
 
Excel macro settings for TIMY-Soft 
 
Start Microsoft® Excel and deactivate macro protection. Microsoft® started providing a 
virus protection function with Excel 97. The default settings for macro protection have 
become more secure with each subsequent version of Excel. Under Excel 97, there is 
simply a warning message and, on later versions, the default setting disables the macros 
sometimes without a warning message. 
 
TIMY-Soft makes use of many macros and, before beginning the installation, the Excel 
macro protection must be deactivated. We guarantee that the delivered software files do 
not contain any viruses. 
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In Excel 97, go to "Tools > Options" and select the "General" tab. Uncheck the box 
marked "Activate Macro alarm" then click "OK". 
 
 
In Excel 2000-2003, go to "Tools > Macro" then "Security". Select the option "Security 
Level Low" and click on "OK". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In Excel 2007, select the "Office" button        and in Excel 2010 or Excel 2013 select 
the "File" tab.              
 
Select "Excel Options" (or "Options" in Excel 2010/2013), and then choose "Trust Center".  
 
In the right hand frame, select "Trust Center Settings" and then "ActiveX Settings". Select 
"Prompt me before enabling all controls with minimal restrictions" and "Safe Mode". 
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In the left frame, select "Macro Settings" and in the right frame select "Enable all macros". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the left frame select "Trusted Locations" and in the right frame select "Add new 
location".  
 
Enter name of the directory in which TIMY-Soft is installed (default is C:\BKS) and then 
select "OK".  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Otherwise, select "Browse" to search for the installation directory. When found, select "OK".  
 
Select "OK" again to return to the Excel main screen. 
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Installing TIMY-Soft Files 
 
Connect the USB-Key to the PC and run Excel. With Excel open, click on "File > Open" 
then click on the menu list "Look in: > My Computer".  
 
Under recent versions of Windows® the Volume Name "BKS" is displayed next to the disk 
icon. The drive description will display the disk letter, e.g. "BKS (F:)". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In Windows®98, the USB-Key is identified by the label "Removable Disk (F:)". 
 
Select "BKS" or "Removable Disk", then the file named "Install.xls" and select "Open". 
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TIMY-Soft is a tri-lingual application. 
Chose the required language: 
 
 
 
 
 
 
 
 
 
 
 
 
The next menu opens if English  
is selected: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Only experienced users should modify the file Path and Directory Name (C:\BKS) 
 
A new directory name can be created, but do not use an existing directory that is used for 
another purpose.   
 
IMPORTANT: The complete path must be typed, including the drive letter of the disk. Do 
not simply enter "My Documents\TimySystem". 
 
To continue the installation, click on "Install Timy-Soft". The installation is very fast, as 
only three files are copied onto the computer. 
 
The installation programme starts TIMY-Soft immediately. The installation is now 
complete. If TIMY-Soft is not required at this time, close the file. To open it later, start 
Excel and open the file "TIMY-Soft.xls" located in the Directory in which it was created 
(default is C:\BKS).  
 
Remove the USB-Key from the PC and secure it in a safe place. It is required every time 
data is downloaded from the TIMY Time Reporting Terminal. The TIMY USB-Key must 
not be used for any other purpose. 
 
IMPORTANT: Avoid moving TIMY-Soft files to another directory after installation.  
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The directory in which the original installation was made can be renamed, but NEVER 
rename any of the files. Renaming files causes TIMY-Soft to become inoperative. 
TIMY-Soft cannot function with shared users on a network, but can be installed on a 
network server for single-user access (single-user access is a function of Excel). 
 
When using TIMY-Soft, never save files manually. TIMY-Soft automatically saves any 
changes, or data modifications, during the closing of the application files. 
 
Never attempt to "Save as..." with another filename. All files must keep the original name. 
 
 
PC Desktop shortcut 
  
If a TIMY-Soft shortcut is required on the PC Desktop display, use Windows Explorer® via 
the "My Computer" Desktop icon. 
 
Open the directory where the files were installed, select the file "TIMY-Soft.xls" with the 
RIGHT mouse button and then click on "Send To > Desktop (create shortcut)". Do NOT 
select the file "TIMY-Soft_Code.xls". This is a password protected application file. 
 

 
A new Excel icon called "TIMY-Soft.xls" is created on the PC Desktop display. 
 
If a back-up copy of the basic TIMY-Soft files is required immediately after installation is 
completed, copy the contents of the directory where the application files were installed 
(default is C:\BKS) and store them in a safe place. 
 
The user is reminded that the USB-Key installation files are deleted by the Time 
Reporting Terminal when the USB-Key is connected for the first time. 
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Using TIMY-Soft 
 
Starting and Using TIMY-Soft 
 
Start Excel, and open the file "TIMY-Soft.xls" found in the directory that was specified 
when the software was installed (default is C:\BKS), or double-click the desktop icon for 
TIMY-Soft. 
 
Whilst opening the TIMY-Soft Workbook, the following message on a red background 
appears very briefly instead of "Employee List". This is normal, and occurs every time the 
application is opened. 
 
 
 
 
 
 
 
 
 
 
 
If the message remains displayed and is not replaced by "Employee List" on a yellow 
background the Excel macro protection has not been deactivated as required. TIMY-
Soft cannot function in this mode and it is not possible to continue.  
 
Close TIMY-Soft and set the macros as described on pages 2 and 3 of this manual, or 
consult the section "Problem Resolution" on page 49.  
 
NOTE: If Excel displays a message asking if changes should be saved, select "No". 
 
 
 
 
 
 
 
 
 
 
The TIMY-Soft system does not contain any data at this stage, and the empty "Employee 
List" worksheet is displayed. 
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Excel 2007, 2010, 2013 Applications 
 

Microsoft made a complete break with all previous versions of Office. This not only affects 
Excel, but also Word, PowerPoint, Access, etc.  
 
In previous Excel versions, files had the extension ".xls" but with Excel 2007, 2010 & 2013 
the extension becomes ".xlsx" for a file without macros, and ".xlsm" for a file with macros. 
 
TIMY-Soft now recognises the installed Excel version 
and displays this information in cell K1 of the 
"Employee List" worksheet, with the file format 
displayed in cell P1: 
 
 
 
 

When opening TIMY-Soft, the application 
checks the Excel version and if files are 
in the ".xls" format AND TIMY-Soft is 
running under Excel 2007, 2010 or 2013, 
a message offering to convert files to the 
".xlsm" format will be displayed: 

 
 
 
IMPORTANT: Before converting, a backup copy of the entire TIMY-Soft directory should 
be made, in the event that a problem occurs with the PC whilst converting. Close TIMY-
Soft before creating a backup copy of the files. 
 
If TIMY-Soft is installed on a single computer, it is recommended that the files be 
converted to the new format. If the conversion is not performed, this question is asked 
every time TIMY-Soft is started. 
 
If TIMY-Soft is installed on a server and accessed from several PCs, of which any one is 
using Excel 2003 or earlier, do not convert the application. After the conversion, 
employee Time Sheets cannot be opened by Excel 2003, or earlier versions. 
 
NOTE: Only convert the format if all PCs are using Excel 2007, 2010 or 2013. 
 
 
When the conversion commences, do not interrupt the 
process as data may become corrupted. The duration of 
the conversion depends on the number and size of existing 
files. If this is a new installation, conversion takes less than 
a second. When the conversion is finished the message on 
the right appears:  
 
Select "OK" and observe that the format indicator in cell P1  
has changed to ".xlsm". 
 
 
NOTE: File conversion is reversible. See the next page for details. If reversion to ".xls" file 
format is performed, the TIMY-Soft application files can run with all Excel versions. 
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TIMY-Soft "xlsm" format reversion to "xls" 
 

TIMY-Soft Version v1.46, and higher, running under Excel 2007, 2010 or Excel 2013 
facilitates the conversion of Time Sheet files to the "xlsm" format. "xlsm" format relates to 
Excel files with built-in macros, and are smaller than similar "xls" files. 
 
The "xlsm" format cannot be opened by Excel 2003, or earlier, versions of Excel, while 
"xls" format can be opened by all Excel versions. 
 
If reversion back to the "xls" format is required, e.g. because a decision is made to use 
Excel 2003 instead of Excel 2010, the following procedure should be followed: 

 
1) Open TIMY-Soft with Excel 2007, 2010 or Excel 2013 
 
2) On the "Employee List" worksheet, select cell K2 showing the Version number. 
 
3) If the Version number is 1.46 or higher, right mouse click on cell K2 and the following 

menu appears: 
 

 
 
 
 
 
 
 
 
 

4) Select "Yes" to revert to the older Excel format. The cursor box at cell K2 will flash at 1-
second intervals and the Status Bar at the bottom of the screen will display the name of 
the file under the reversion process 

 
5) At the conclusion of the process or if "No" is selected, or a Version prior to v1.46 is 

running, the next menu opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
6) Close the menu with the "X" at the top right corner, and not with "OK".  

 
7) If TIMY-Soft is re-started with Excel 2007, 2010 or 2013, the centre message on page 

8 will display. 
 
8) If TIMY-Soft is re-started with Excel 2003 or earlier, the message on page 8 will not 

display. 
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Extending Calendars 
 

After entering a list of employees and closing TIMY-Soft, if it is re-started on any later 
date the application displays the following message: 
 
 
 
 
 
 
 
 
 
 
 
Why is the "Extend Calendars" message displayed? 
 
To be able to store Time Stamps (clocking) data from the USB-Key, the employee Time 
Sheets must be re-initialised by writing one new line for every subsequent day since the 
last time "Extend Calendars" was performed up to, and including, the current date of the 
computer. 
 
For example, if TIMY-Soft is opened on Monday 01/11/2014, and "Yes" is selected on the 
message above, the application automatically extends the TIMY-Soft calendars from the 
last date recorded in every Time Sheet, up to, and including, 01/12/2014.  
 
If the application is next opened on Monday 08/12/2014 and "Yes" is selected on the 
"Extend Calendars" message, TIMY-Soft adds lines for the dates of 02/12/2014 to 
08/12/2014 into every Time Sheet file. 
 
It is therefore imperative that the computer date is correct. 
 
The "Extend Calendars" function is optional, because the process can take some time 
under some circumstances. For example, if there are 300 registered employees and the 
calendars are to be extended by 30 days the process may take several minutes. If the 
user only wants to review previously added Time Sheet data (e.g. during dates between 
payroll calculations), skip this operation by clicking "No" and TIMY-Soft is immediately 
available. 
 
If, while in this session, it is intended to retrieve new Time Stamp data from the USB-Key 
it is essential that the Time Sheets be re-initialised up to the current date, otherwise 
TIMY-Soft cannot store the Time Stamp clocking data in the employee Time Sheet files. It 
is therefore necessary to answer "Yes" if the intention is to "Get Clocking Data" from the 
USB-Key during the current session. 
 
If TIMY-Soft is run again on the same day that the calendars have already been updated, 
the "Extend Calendars" message does not appear. 
 
From TIMY-Soft version 1.49, the function of 
retrieving new Time Stamp data from the USB-
Key is not permitted unless the calendars have 
first been extended. The following message is 
displayed in this situation: 
 
Follow the instructions and then select  
"Get Clocking Data" again. 
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Planning Mode 
 
The ability to write future dates into all existing Time Sheets was implemented from 
version 1.33 onwards. This allows for pre-planning of vacation and holiday breaks. 
 
To add future dates, cell I2 in the "Employee List" worksheet is unprotected. If a number 
is entered into cell I2 (e.g. 30, followed by the keyboard "Enter") TIMY-Soft can "Extend 
Calendars" for the selected number of days when the application is next opened.  
 
Close TIMY-Soft, re-open it and answer "Yes" when the "Extend Calendars" message 
appears. TIMY-Soft checks that cell I2 content is numeric. If not, cell I2 content is erased 
and "Extend Calendars" is cancelled. If the content is numeric, "Extend Calendars" proceeds 
and all Time Sheets have additional date lines written into the files. Erase the value in cell I2 
after performing the "Planning Mode" extension.  
  
Note: Cell I2 is easily selected using the keyboard cursor keys instead of the mouse.  
 
 
Removing 'seconds' from new Time Stamps 
 
The TIMY Time Recorder registers ID-Badge time stamps in hours, minutes and seconds. 
The seconds do not appear in the employee Time Sheets for space reasons but, when a 
time stamp is selected, the Excel Formula Bar displays the full data including seconds. This 
method assures precision, but can be the cause of misunderstanding as any manual 
calculation for a given time period based on rounded hours and minutes may differ to the 
result calculated by the TIMY-Soft application.  
 
Seconds can be forced to display "00" whenever Time Stamps are imported from the USB 
Key by setting cell G2 in the "Employee List" to "00" (without quotes). It is NOT possible 
to reset any existing time stamps that were previously imported from the USB Key. 
 
 
TIMY-Soft worksheet descriptions 
 
The TIMY-Soft workbook has six worksheets: 
 
 
 
 

-  Employees: Details of Family Name, First Name, Empl-No. (must be unique for 
each person), Badge-No. (unique), and Start-Date (Start-of-Clocking) are here. 

 
- New Records: Temporarily stores Time Stamp data coming from the USB-Key. 

Here, the Time Stamps are sorted by Badge Number, Date and Time before being 
inserted in the individual Time Sheets. Normally this sheet is always empty and 
would not have to be consulted unless TIMY-Soft advises that there is a problem. 
Time Stamps that, for various reasons, cannot be imported into the Time Sheets are 
saved here. 

 
- Clocking Errors: Lists certain errors related to Time Stamps, such as missing Time 

Stamps. TIMY-Soft automatically opens this sheet after selecting the Control Panel 
button "Search Errors". 

 
- Summary: Displays results when the Control Panel button "Show Summary" is 

selected. TIMY-Soft automatically opens this sheet when the "Summary" report is 
ready. The displayed information remains in this worksheet until the "Show 
Summary" button in the Control Panel is re-selected. The results of this report can 
be exported to an external Excel file, and then saved. 
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- Correction Codes: At installation, this sheet contains four standard "Absences" as 
examples. Additional "Correction Codes" can be added, or the standard codes can be 
deleted if required. Upon deletion of any code, TIMY-Soft checks to ensure that the 
code is no longer used in any Time Sheet. If the code is used, deletion is not 
possible until the code is removed, or replaced by another code in all Time Sheets. 

 
- Print Time Sheets: This worksheet is used to print employee Time Sheets. Click on 

any cell with the RIGHT mouse button to call up a menu in which employees can be 
selected. TIMY-Soft copies the Time Sheets into this worksheet, with or without page 
breaks. Print the whole worksheet with the standard Excel "Print" command. The 
results of this report can be exported to an "external" Excel file, and then saved. 

 
TIMY-Soft files and related worksheets are automatically protected. As a result, data 
cannot be entered directly into the cells of any Time Sheets, except within the columns 
AR-BK. Columns AR-BK can accept additional calculation formulae entered by the system 
user (see pages 41-47, Customer-Specific Calculations).  
 
The "Summary" and "Print Time Sheets" reports are unprotected worksheets, and 
comments can be manually entered.  
 
Password Protection 
 
The main "TIMY-Soft.xls" file is not protected. The user may want to restrict access to 
this file and therefore to the entire TIMY-Soft Time Reporting System. To minimise the risk 
of unauthorised access a password can be assigned to the file by using the standard Excel 
procedure File > Save As > Tools > General Options > Password to open then enter a 
password. Click on "OK" and confirm with the same password in the next step and then 
select "Save". Make a safe record of this password. 
 
NOTE: Never change the file type from ".xls" during this procedure. 
 
Select "Yes" when advised by Excel that "TIMY-Soft.xls" already exists: 
 
 
 
 
 
 
 
 
 
The file must be saved with the same name of "TIMY-Soft.xls" in the same directory 
(C:\BKS) or the directory that was defined at the time of initial software installation. 
 
The next time that TIMY-Soft is started the password is requested. 
 
Do not forget the password - there is no way to read the system data without it. 
 
 
Employee Registration 
 
TIP: In order to understand the operation of TIMY-Soft, it is recommended a fictitious 
employee is created and assigned with a start date of a few days prior to the current 
date. Time Stamp data can be created with an ID-Badge on the Time Recorder unit, and 
imported with the USB-Key. Any time absences in the fictitious employee Time Sheet can 
be viewed and the various parameter settings related to this data can be tested. When the 
test data is completed, delete the fictitious employee from the system and return the ID-
Badge to the stock of badges. 
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On the main "Employee List", if the widths of the columns A to E need to be changed, click 
on the corresponding column title (e.g. Family Name) with the RIGHT mouse button. The 
"Set Column Width" menu appears, allowing the entry of a new column width:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the desired width (in pixels) and click on "Go!"  
 
Close the Set Column Width menu by clicking on the "X" in the upper right-hand corner. 
 
To register a new employee, click on the Control Panel button "New Employee". The 
"Creating new Employee" menu opens, ready for employee registration: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- Family Name and First Name(s): These are "free text" fields and any character can be 
used. It is recommended that the Family Name be capitalised. 
 
- Empl-No: TIMY-Soft needs a unique "key" to identify each employee, which is the 
Employee Number. During the creation of an Employee Number, TIMY-Soft verifies that it 
has not been assigned to another employee. 
 
If a unique Employee Number is already used for payslips, or other employee documents, 
it is recommended that the same number be used in TIMY-Soft. This allows easy 
reconciliation of TIMY-Soft data with the other employee documents. 
 
The use of the Employee Number as a "key" (instead of the ID-Badge number) allows 
assignation of a new ID-Badge in the event of loss of an ID-Badge. This negates the need 
to obtain an ID-Badge with the same number as the lost ID-Badge. Employee Time Sheet 
records are based on the Employee Number "key" and not on ID-Badge number. 
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- Badge-No: TIMY-Soft checks to ensure that this number has not been assigned to 
another employee. CAUTION! TIMY ID-Badges use figures and capital letters. Do not 
confuse the number "0" (zero) and the capital letter "O", or number "1" with letter "I". 
 
- Start-Date: Clocking data created before this date can never be displayed by TIMY-
Soft, and this date cannot be modified later. It is possible to enter an earlier date or a 
future date relative to the current date. A confirmation is required if a date is entered 
more than ±30 days from the current date. The calendar for the employee is automatically 
generated by TIMY-Soft, and a "Time Sheet" file is created commencing with this Start-
Date. 
 
As with ALL dates in TIMY-Soft, enter the day and the month with the correct separator 
(e.g. "1/5" for the 1st of May if the Windows date separator is set to "/"). As soon the 
computer "Enter" key is pressed, the date is set to the complete format (e.g. 
"01/05/2005"): 
 

 
When entering dates in this fashion, Excel always uses the current year, so be careful 
during December and January. During January 2013, if the value "27/12" is entered Excel 
turns that into "27/12/2013" and not "27/12/2012". 
 
If the year is not entered do not use the separator after the month, otherwise an error 
message appears: 
 
 
 
 
 
 
 
 
When the details are completed, select "Go!" to create the employee Time Sheet and, in 
the case of a retroactive starting date, the initialisation of the calendar includes any earlier 
dates. As soon as the "Creating new Employee" menu is blank, start with another 
employee registration. To leave the menu, click on "Close". The "Employee List" is 
automatically sorted by family name when the "Creating new Employee" menu is closed. 
 
An example of the data entry for a new employee is shown below: 
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TIP: If TIMY-Soft is managing a large number of employees, it is possible to have the 
"Employee List" sorted by work department. The "Employee List" can be sorted by 
preceding the Family Name with a code to signify the department. For instance, "ADM-
JONES" if Jones works in the Administrative department and "PRD-SMITH" if Smith works 
in Production.  
 
TIMY-Soft sorts on the complete content of the Family Name field, so all the employees 
with "ADM-" appears before those with "PRD-". Within each department group, employees 
are sorted by Family Name. Use "Modify Employee" to add the code in front of the Family 
Name. 
 
 
Modify Employee 
 
Select an employee from the list of names in the "Employees List" main menu and click on 
the Control Panel button "Modify Employee". The menu opens to allow changes in the 
Family Name, First Name, Empl-No and Badge-No. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Delete Employee 
 
To delete an employee entirely, on the "Employee List" main menu chose the employee 
and in the Control Panel click on the button "Delete Employee". A confirmation is required, 
as this operation is irreversible once completed. 

 
 

WARNING: It is NOT possible to recover any data for a deleted employee! 
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Displaying Time Sheets 
 
A Time Sheet (an Excel workbook file) is automatically created whenever an employee is 
registered (see pages 12-14, Employee Registration). 
 
Before displaying a Time Sheet, the range of dates to be displayed must be selected for 
the calendar period required under "Active Period" in the Control Panel. Select the date 
range required by clicking on one of the date panels.  
 
The date range is saved by TIMY-Soft until it is changed again - it does not have to be 
changed each time the application is started. The date range is also used for three 
functions launched from the buttons located on the right side of the Control Panel. These 
are "Search Errors", "Show Time Sheet" and "Show Summary". 
 
To change the dates, click on either of the two date panels and the "Active Period" menu 
opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the "Employee List", select the employee Family Name row to be viewed and then click 
on the Control Panel button "Show Time Sheet". 
 
The employee Time Sheet is displayed for the date range specified under "Active Period":  
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Time Sheet Contents 
 
1) Dates in column B: a light blue background identifies weekends. 
 
2) Up to 10 Time Stamps per day for each employee (corresponding to five work periods) 

can be managed by TIMY-Soft. All Time Stamps imported from the USB-Key are placed 
in chronological order in the Time Sheet in cells "Start 1" to "Stop 5" (columns C to L).  

 
The Time Stamps for any given day are re-sorted every time a new Time Stamp is 
added. This feature ensures that in larger applications with several Terminals and 
several USB-Keys, with employees clocking in and out at different terminals, the Time 
Stamps are still sorted correctly in chronological order, even if a "Start" time is 
imported after a related "Stop" time. 

 
3) "Hours Clocked" in column M calculates the total number of hours recorded in a the 

day, based on the Time Stamps made by the employee when "Clocking", without taking 
account of any underlying time models. "Hours Clocked" is the sum of the times 
between each pair of "Start/Stop" times, i.e. (Stop 1 - Start 1) + (Stop 2 - Start 2) + 
(Stop 3 - Start 3), etc. 

 
4) Absence and Duration are manually recorded in columns N to Q, the hours of which are 

added, or deducted, from the "Hours Clocked" (full details are discussed on page 23). 
 

The values of columns O and Q (Absence/Durations) are added to, or deducted from, 
"Hours Clocked" with the result showing in "Net Hours" (column T).  
 
Duration in column S does not deduct or add time because any Correction in column R 
is used to record unpaid time-off and does not have any effect on the "Net Hours".  
 

5) Every Sunday the sum of the preceding 7 days (including Sunday) is automatically 
displayed in column AQ "Total Week". 

 
6) At the bottom of the worksheet, TIMY-Soft calculates the totals for "Hours Clocked" and 

"Net Hours" for the Active Period selected, as well as the sums for any Absences 
occurring in the same Active Period. 

 
 
Modifying Time Sheets 
 
NOTE: Time Sheet data cannot be directly modified on the Excel worksheet, but it can be 
modified in several ways, described below:  
 
Time Stamps Manual Entry 
 
It is likely that an employee occasionally forgets to Clock-in or Clock-out, especially in the 
early days of using the TIMY-System. 
 
Correction is very simple. Open the employee’s Time Sheet and with the RIGHT mouse 
button select the first blank cell of the day concerned (e.g. to the right of 13:45 in the 
example): 
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The "Add or Modify Time Stamps" menu opens:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the missing time in the "Enter/Modify Time Stamp" field at the bottom of the menu 
and press "Enter" on the computer keyboard to validate the data. Only use the colon (:) 
symbol to separate hours and minutes (or whichever symbol is defined in the Regional 
Time and Language Settings for the computer). 
 
To delete an entry move the cursor to the entry to be removed and use the computer 
keyboard "Delete" key to erase the entry in the "Enter/Modify Time Stamp" box. Then 
press "Enter" on the keyboard. 
 
TIMY-Soft sorts the Time Stamp data automatically and put them in chronological order. 
Any manually added or modified Time Stamp data is displayed in bold to show that it did 
not occur because of an employee ID-Badge swipe. In addition, on the date cell in column 
"B", an Audit Trail is created, with a comment showing the Date and Time that the 
modification occurred. 
 
 
 
 
 
 
 
 
The next cell on the right is automatically selected to allow the addition, or modification, 
of another Time Stamp without needing to use the mouse or cursor key. 
 
If the "Add or Modify Time Stamps" menu obstructs the view of the Time Sheet, it is 
possible to move the menu by clicking and holding the blue title bar with the LEFT 
mouse button and then dragging the menu. Release the mouse button when satisfied with 
the position of the menu. 
 
The "Add or Modify Time Stamps" menu remains on the screen to allow other corrections 
quickly. It is possible to move within the "Time Sheet" screen with the computer keyboard 
Cursor Keys without leaving the "Add or Modify Time Stamps" menu. A whole day (or more) 
of Time Stamps can be modified in the event of forgetfulness or loss of an ID-Badge. 
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TIP:  to skip to the first cell of the next day, press the "Next Page" or "PgDn" Key on the 
computer keyboard. To return to the first cell of the previous day use "Previous Page" or 
"PgUp". 
 
 
Audit Trail after Modifying Time Sheets 
 
Whenever a time stamp is modified, added or deleted from a Time Sheet by the TIMY-Soft 
user, a comment is automatically added to the date cell on which the change has 
occurred, indicated by the Excel "comment tag". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Moving the mouse cursor to the date cell will allow the comment to be displayed. 
 
Time Calculations using Time Models 
 
In certain cases, the measurement of total time between Time Stamps may not be 
required, but only the attendance time within certain time ranges. For example, if the time 
clocked before 08:00, or after 16:30 should not be counted. This could also apply to the 
midday break. A fixed lunch break between 12:00 and 13:00 can be set by stopping the 
count of time at 12:00 (even if the employee clocks out after 12:00) and re-start 
counting at 13:00 (even if the employee clocks in before 13:00). TIMY-Soft uses a simple 
implementation of daily "Time Models" to truncate the time to a fixed schedule, even 
though the employee is "present at work". 
 
In the example below, before setting time model parameters, the total time counted for 
the 11/04/2005 is 7.87 hours (7 hours and 52 minutes). 
 
 
 
 
 
 
 
 
Let us say that any time clocked before 08:00, or any time clocked after 16:30, should 
not be calculated. I.e. The employee should not be "compensated" for a late arrival in the 
morning by a late departure in the afternoon. Simply click on one of the Time Stamp cells 
with the RIGHT mouse button to open the "Add or Modify Time Stamps" menu, and then 
select "Time Parameters".  
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This opens a second menu for the "Time Models" and makes it possible to specify time 
limits for each of the 10 different Time Stamps, as below: 

 
As a presence before 08:00 should not be counted (i.e. only count hours starting from 
08:00) enter "08:00" in the box "Start 1". In the afternoon, as a presence after 16:30 
should not be counted, enter "16:30" in the box "Stop 2". At this time, we do not care to 
apply "Time Parameters" to the Time Stamps for mid-day, and "Stop 1" and "Start 2" 
remain blank. 
 
When opening this menu, TIMY-Soft enters the date of the chosen date line in the "Apply 
from" and "Through" fields. If the entry is validated by clicking on "Go!" without modifying 
these dates, the "Time Parameters" rule applies only to the selected date. If this rule 
should be applied to several days (for example, the entire week of the 11/04/2004 to the 
15/04/2005) replace the dates in these two boxes by the desired dates, and then validate 
by clicking on "Go!" 
 
If this rule should be applied automatically to all future days not yet created in the Time 
Sheet, check the box "Use these values as default". 
 
In our example, we wish to assign this rule to the complete week of the 11/04, and not 
use it by default. After validation, the entries and the durations appear as follows: 
 
 
 
 
 
 
 
 
 
Those Time Stamps for which TIMY-Soft applied Time Models are colour coded to highlight 
the fact that the duration is no longer calculated based on the employee "clocked" hours.  
 
For the start time of 07:58 on the 11/04, TIMY-Soft used the new time of 08:00 for the 
calculation of work duration. The same applies for the last Time Stamp on 11/04. Instead 
of 16:42, TIMY-Soft counted the time only up to 16:30. The "Net Hours" counted are 
therefore 7.63 compared to the 7.87 originally Clocked Hours. 
 
As the first clock-in (Start 1) on the 12/04 was actually after the Time Model setting, TIMY-
Soft used the original Time Stamp. Similarly, at the end of the day of 13/04, the employee 
departed early than 16:30 and the actual Time Stamp value was used to calculate the 
worked presence duration. 
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If a mid-day break should be fixed between 12:00 hours and 13:00 hours (i.e. no counting 
of Time Stamp hours during this period) it is simple to apply the "Time Parameters" by 
entering "12:00" in the box "Stop 1" and "13:00" in the box "Start 2".  
 
After validation, the entries appear as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The resulting time calculations are highlighted as follows: 
 
 
 
 
 
 
 
 
 
The total of 7.50 hours calculated for the date 11/04 corresponds to (12:00 minus 08:00) 
+ (16:30 minus 13:00). To obtain a "theoretical" 7.50 hours work, the employee must 
"Clock-in" before 08:00 and 13:00, and "Clock-out" after 12:00 and 16:30. 
 
The "Time Parameters" settings can be modified at any time and are applied individually 
to each employee Time Sheet. 
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Time Capping 
 
In some situations, there may be a requirement to impose time models, but limit the 
maximum time paid per day (for example, 7 hours and 30 minutes). In this case, do not 
enter anything in the time boxes but enter the duration in the box "Max time/day" in 
hours and decimals (e.g. 7.5) to which paid time should be limited. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If necessary, this type of limitation can be set by "default". However, if the capping limit is 
not to be applied for a given day, or a different value should apply, it is easy to call up the 
"Time Models" screen and remove or modify the value for the day concerned. To show 
that a capping limit is set, the cell "Net Hours" (column T) for the day affected is coloured 
coded: 
 
 
 
 
 
 
 
 
NOTE: When applying a parameter setting by "default", it is applied to all future days. It 
cannot apply to past days already created in the calendars. 
 
To apply a parameter setting to an existing (earlier) group of dates in the Time Sheet, use 
the boxes "Apply from" and "Through". The dates entered here must exist in Time Sheet 
displayed. If are not displayed, change the "Active Period" in the TIMY Control Panel to 
allow the calendar period to be shown. 
 
 
Straddling Midnight 
 
Work schedules which straddle midnight pose particular problems for all time management 
programmes, because the "Clock-out" Time Stamp is occurs on a day later than the related 
"Clock-in" Time Stamp. There are two ways to manage this sort of situation with TIMY-Soft. 
 
If the case arises only occasionally, a manual correction can be made with a couple of 
mouse clicks. 
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Midnight Hours Manual correction 
 
In the example below, the employee began work at 20:05 on 18/04/2005, and finished at 
04:03 on 19/04/2005. In the evening of 19/04/2005 the employee began again at 19:57 
and finished at 04:02 on 20/04/2005. 

 
 
Click on any Time Stamp cell of the 18/04 with the RIGHT mouse button to call up the 
"Add or Modify Time Stamps" menu and click on the "Midnight X-Over" button: 
 
 
 
 
 
 
 
This causes the first Time Stamp of the next day (04:03 on 19/04/2005) to be transferred 
to the selected day. 24 hours is added to the value so that the sort routine and the formulae 
function correctly. The other Time Stamps on the next day are shifted automatically to the 
left by one cell. The result is:  
 
 
 
 
 
 
The time in the second cell on the 18/04 is displayed by Excel as "04:03", but the actual 
value is "28:03". This can be verified this by using the cursor keys to navigate to this cell 
and checking the value displayed in the menu: 
 
 
 
 
 
NOTE: If there is a need to manually enter a Time Stamp which was made on the next 
day, remember to add 24 hours. 
 
When "Midnight X-Over" was selected on the date of 18/04, TIMY-Soft made the correction 
shown above and simultaneously selected the next day. To correct several days in a row 
simply click repeatedly on the "Midnight X-Over" button.  
 
In our example, if we click on the button again, 19/04/2005 is also corrected, to give the 
following result:  
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Midnight Hours Automatic correction 
 
If there are employees who are regularly present at midnight, it is possible to automate 
the "Midnight X-Over" action. Do this by entering a limit time in cell 'B6' on individual 
Time Sheets (this cell is not protected):  
 
 
 
 
 
 
This allows TIMY-Soft to transfer any newly imported Time Stamps made before this time 
to the previous day, when the Time Stamps are imported from the USB Key, if the 
number of Time Stamps on the previous day is odd, and the time difference 
between the last Time Stamp on the previous day and the Time Stamp to be 
transferred is less than 10 hours. 
 
Allow sufficient buffer time in the value of cell B6 in case of late "clock-out" due to 
overtime requirements. If, for example, the time is set as 07:30, but the employee 
"clocks-out" at 08:30, the automatic "Midnight X-Over" cannot occur and a manual 
"Midnight X-Over" must be performed 
 
The automatic "Midnight X-Over" action cannot be retro-actively applied to Time Stamps 
that already exist in any Time Sheets. It is only applied to Time Stamps when they are 
imported from the data file on the USB-Key or "New Records". 
 
 
Absence and Corrections Management 
 
TIMY-Soft can be used to manage Employees' absences, and to add (or substract) manual 
corrections in the employee’s Time Sheet. ALL corrections are entered in hours and 
decimal parts of hours, and not in days. 
 
Absences entered in columns N-O (Absence1) and P-Q (Absence2) are added to the "Net 
Hours", i.e. they are considered to be equivalent to a physical presence. Data entered in 
columns R-S (Correction) remain neutral and have no impact on the "Net Hours". Columns 
R-S are used to document unpaid time off. 
 
To explain the operation of these corrections, see the following example: 
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For the date 22/12/2003: The employee only "Clocked-in" in the morning, and our 
"Time Model" rules truncated the time before 07:30 and after 12:00, to record only 4.5 
hours of "presence". The employee, who was unwell in the afternoon, was granted 2.5 
hours Sick Leave  (corresponding to the time that the employee would have normally 
worked during the afternoon). As the column Absence 1 is "compensated time" this is 
added to Clocked Hours ("Net Hours"). The total time counted for the day is 7.0 hours. 
 
For the date 23/12/2003: The employee only "clocked-in" in the afternoon because of 
sickness in the morning. The two Time Stamps in this case originally filled the first two 
boxes (TIMY-Soft does not have any way of knowing that the two first Time Stamps of the 
day do NOT belong in columns "Start 1" and "Stop 1"). We manually shifted them into the 
second columns ("Start 2" and "Stop 2") with the modification function "Shift >>" so that 
the "Time Model" rules are correctly applied. The employee thus carried out 2.5 hours of 
activity this day, and we added a 4.5 hours "compensated time" for the same reason as 
the day before. 
 
For the date 25/12/2003: The employee did not "clock-in" because it is a paid holiday. 
7 hours of "HOL" are applied. 
 
To enter an Absence or Correction, click in the Absence (or Correction) column N, P or R 
with the RIGHT mouse button. A menu appears allowing the entry of a Duration (in Hours 
and decimals of an hour) and "Select a "Reason from the List": 
 
 
 
In "Enter the Duration in Hours", type 
the value required in decimal format, 
followed by the "Enter" key on the PC 
keyboard.  
 
The cursor automatically moves on to the 
"Select a Reason" box. Click on the drop-
down list to select a code (or the first 
letter of the reason code).  
 
After a code is chosen, use the "Enter" 
key to validate the entry.  
 
The correction is applied and the next 
line in the worksheet is automatically 
selected.  
 
 
 
 
Correction Codes 
 
The list of Reasons is maintained in the "Correction Codes" worksheet tab. Reasons can 
be added or deleted as required. It is suggested that Codes are limited to 3 characters in 
order to fully display them in the Time Sheet columns. 
 
TIMY-Soft remembers the values previously entered in the menu. Thus, if several days 
require the same absence entry (e.g. a week of paid holiday) it is sufficient to press 
"Enter" + "Enter" for each day. 
 
[The opportunity to copy the same settings to all employee Time Sheets is possible with 
this menu. If this is not required, close the menu with the X at the top right corner.] 
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It’s possible to also navigate within the Absence columns by using the Cursor Keys, just 
like when handling the Time Stamp columns. If two weeks of paid holiday need to be 
entered, when Saturday of the first week is reached, press twice on the keyboard "Down 
Cursor" key to position the cursor over Monday of the following week, then continue with 
"Enter"  + "Enter" several more times. This way it’s possible to add 2 weeks of paid 
holidays in a few seconds. 
 
TIMY-Soft copies the cell values into the menu only when using the "Cursor Up" key. 
When the "Down Cursor" key is used, whatever values were last stored in the menu 
remains. Thus, it’s possible to copy a value of an earlier cell and re-use it in a lower cell. 
To quickly cancel an already entered value, go up to the first line where the cells are 
empty, then descend again to the cell to be cancelled, and press "Enter" + "Enter". 
 
It is possible to directly select a value to be erased by clicking on the "Absence" cell with 
the RIGHT mouse button. In the menu, delete the "Duration" value, and press the 
keyboard "Enter" key, then delete the "Reason" and press the keyboard "Enter" key. 
 
 
Hiding Columns 
 
By default, TIMY-Soft shows all 10 columns of Time Stamp data (Start 1 to Stop 5) and 
various Totals. If, in the business environment, the employees never "Clock" more than 4 
times a day, the worksheet columns G-L (Start 3 to Stop 5) can be hidden to make the 
Time Sheet more compact. With the RIGHT mouse button, click in one of the cells in the 
column titles e.g. cell G7. The "Hide/ShowTime Stamp Columns" menu appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It’s possible to hide the columns of any Time Stamps that do not need to be displayed. 
The user can hide the daily Hours Clocked or Net Hours if, for example, another "Total" 
formula is desired in the free columns (AR to BK). It’s possible to revert at any time to the 
"Hide/ShowTime Stamp Columns" menu to show a previously hidden column.  
 
This parameter setting relates only to the viewing of the sheet - it does not have any 
effect on Time Stamp management. For example, if only four Time Stamps are set to be 
visible (Start 1 - Stop 1 and Start 2 - Stop 2) and an employee actually “clocked” six 
times (two more than anticipated) the Time Stamp entries "Start 3" and "Stop 3" are 
always in the employee Time Sheet. The Totals are always correctly calculated, but the 
additional Time Stamps cannot be displayed until "Start 3 - Stop 3" are "unhidden" using 
the method above. 
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About the Time format 
 
The Time Stamps are shown in hours and minutes. However, time periods or durations are 
always shown in hours, tenths and hundredths. In Excel it is very difficult to perform 
calculations on durations in hours and minutes format (e.g. it is not possible to display a 
negative duration in hours and minutes) and users should be familiarised with the 
representation of the time in the form of hours and decimals (15 minutes = 0.25 hours; 
30 minutes = 0.5 hours; 45 minutes = 0.75 hours, etc) when Time Sheets are shown. 
 
If the totals must be represented in hours and minutes format, refer to the section Time 
format in Hours and Minutes on Page 48. 
 
 
Closing a Time Sheet 
 
To close a Time Sheet, click on the      in the control box on the top right of the open 
worksheet page (NOT the Excel      at the extreme top right) or use the Excel command 
"File > Close". Alternatively, Alt + F4 also closes an open file. When a Time Sheet is closed 
correctly with these methods TIMY-Soft saves any changes automatically without any 
further action and the user is returned to the "Employee List" main menu.  
 
Never click on the diskette icon       to save information. TIMY-Soft saves files 
automatically, and in the correct format when they are closed. 
 
 
Search for Errors 
 
To quickly identify any errors, such as omitted Time Stamps, or days with "Absent without 
Reason", TIMY-Soft can search all errors for all employees for any time period selected in 
the Control Panel "Active Period". 
 
First, ensure that the correct date range is selected, then click on the Control Panel button 
"Search Errors". The "Find Errors" menu opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- Odd number of Time Stamps: When checked, the search includes days when 
employees "Clocked-in" but did not "Clock-out", or vice versa. Excel cannot calculate a 
daily total for days with incomplete Time Stamp pairs, and so it is necessary to manually 
add a Time Stamp in such circumstances. 
 
- Absent without Reason: When checked, TIMY-Soft includes all days for which there 
were no Time Stamps at all and no Absence or Correction entered. By default, TIMY-Soft 
tests only the normal working days of the week. If employees work on weekends, include 
Saturdays and Sundays in the search. 
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- Daily Presence < (less than): If employees must be present for a minimum number of 
hours each day, a search can be initiated for days where this minimum is not achieved. 

  
NOTE: Even if the Daily Presence function has not been selected, a duration (e.g. 8.0) in 
the "Hours" field must be present. TIMY-Soft checks the format validity of this field. 
 
When the required selections have been made, click on "Go!"  
 
TIMY-Soft carries out the search and reports the result in the "Clocking Errors" 
worksheet tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to correct an error in this list, RIGHT mouse click on a cell in the "Error Type", 
(column D).  TIMY-Soft opens the employee's Time Sheet at the chosen line and a 
correction can be performed immediately. Corrected errors are not immediately removed 
from the "Clocking Errors" report, and do not appear when "Search Errors" is run again. 
 
When all errors are corrected, return to the "Employee List" main menu and re-run the 
"Search Errors" again. If the errors were corrected, the "Clocking Errors" report is now 
empty. 
 
 
Print Time Sheets 
 
For the dates chosen in the "Active Period", any Time Sheet is printed individually by 
calling up each one with "Show Time Sheet" and using the standard Excel printing function 
to print part or all of the Time Sheet.  
 
However, this is time-consuming if there are more than a few employees to be viewed. 
 
The fastest and most convenient way is to use the built in "Print Time Sheet" function 
described on the next page.  
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Click on the worksheet tab "Print Time Sheets", and then click in any cell on the sheet with 
the RIGHT mouse button to call up the "Select Employees" Menu:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the "Selection list" panel highlight the employees for which Time Sheets need to be 
printed and then click on the ">" button to transfer them to the "Employees selected" 
panel on the right. 
 
All employees can be transferred to the right hand panel by using ">>>".  
 
To transfer multiple random employees, hold down the "Ctrl" key on the computer 
keyboard while selecting on the required names with the mouse. To select a consecutive 
list of names, click on the first name, hold the "Shift" key and select the last name.  
 
To cancel the selection and start over, click on "Reset". 
 
When all selections are complete, click on "Go!". TIMY-Soft makes copies of the Time 
Sheets for all the employees selected and copy them into this worksheet, complete with 
page breaks (if chosen). The entire contents of the report can now be printed with the 
standard Excel print function, or exported to an external Excel file. 
 
NOTE: The data remains in this worksheet until replaced by new data.  
 
It is good practice to erase this report when finished with by clicking in any cell on the 
sheet with the RIGHT mouse button to call up the "Select Employees" Menu. Simply 
selecting "Go!" clears the screen.  
 
This action will result in a smaller Timy-Soft.xls file when the system is closed, which 
enhances the system speed the next time it is opened. 
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Export Print Time Sheets report 
 
After a "Print Time Sheets" report is created, right click again on the display, select the 
"Export" function at the bottom right in the "Select Employees" screen. Select "Yes" in the 
next message and a new Excel file is created, as Book 2 or Book 3, etc: 
 
 
 
 
 
 
 
 
Use the Excel "Save As" function to rename the file appropriately. Return to TIMY-Soft by 
clicking on the "Timy-Soft" tab in the Windows Toolbar. 
 
 
Show Summary 
 
For help in the preparation of payroll slips, TIMY-Soft can create a "Summary" report  
comprising of one line for each employee showing the number of "Time Clocked" hours, 
the number of "Time Calculated" hours (including compensated Absences) as well as totals 
for all Absence Reasons: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Export Summary report 
 
After a "Summary" report is created, right click again any cell on line 3, e.g. Family Name. 
Select "Yes" in the next message and a new Excel file is created, as Book 2 or Book 3, etc: 
 
 
 
 
 
 
 
 
Use the Excel "Save As" function to rename the file appropriately. Return to TIMY-Soft by 
clicking on the "Timy-Soft" tab in the Windows Toolbar. 
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Compact or delete old data 
 
From time to time it is useful to delete older data, if the Time Stamp history is not 
required to be kept electronically beyond a minimum legal period. Select the 
"Compact/Delete" function on the Control Panel: 
 
 
 
 
 
 
 
"Compact/Delete" allows two different functions, shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
"Replace all formulae …" is selected by default. This removes all formulae in all the Time 
Sheets and replaces them by their calculated values. 
 
"Delete all data older than the date below" removes historical data. This totally deletes all 
time stamps data and any related calculations prior to the date entered. 
 
Replace all formulae  
 
If TIMY-Soft was implemented in 2009, there are several years of history and each time 
sheet is probably over 1.0Mb. The user could reduce the file size by deleting calendar 
dates, but does not know if there will be future reasons to consult this older information. 
 
Using the "Replace" function, for example by entering 01/01/2012 as the stop date and 
click "Go!" reduces file sizes. The system replaces all the formulas with their numerical 
values from the installation date up to, and including, 31/12/2011. 
 
There is no apparent difference in the time sheets when using "Show Time Sheet" but 
there are significant differences within the structure of the cells. 
 
On a time sheet file that has not been compacted, a cell in column M ("Hours Clocked") 
displays something like "= SUM((C14-D14)*24,(F14-E14)*24,(H14-G14)*24,(J14-
I14)*24,(L14-K14)*24)" in the Excel "Formula Bar". The value displayed in the cell might 
be 7.20, for example. 
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When this time sheet file is compacted, the value 7.20 is displayed in the Excel "Formula 
Bar" instead of the formula. The numerical value uses less characters than the formula, 
hence the benefit in performing the "Replace all formulae" operation. 
 
NOTE: Changes cannot be made to any data that is compacted. 
  
When using "free" columns in timesheets (columns AR-BK) with the functions of the 
optional "Forms" software module, compaction can have a second use. 
 
Many of these functions use the cells in rows 5 and 6 for setting parameters. If it is 
desired to change the settings from a certain date, it is not possible because all history 
prior to that date is also changed, as settings in lines 5 and 6 apply to the entire column. 
This situation is particularly difficult when setting up counters such as cumulative daily or 
weekly differences. 
 
With this new compaction feature, the entire history can be "frozen" until the day 
preceding the effective date of the change. Any changes can be made from the effective 
date (whether in cells format or outright replacement of a function by another), knowing 
that the history can never change. 
 
Delete Calendars 
 
This function is identical to the previous method and totally removes the history before the 
specified date. "Deletion" is irreversible and it is imperative to backup the TIMY-Soft files 
prior to this action and to understand the significance of "Delete old data …". 
 
 
 
 
 
 
 
 
 
 
A confirmation is required. If "Yes" is selected, all the data BEFORE the chosen date is 
deleted. In the example above, data after and including 31/12/2011 is retained. 
 

WARNING! This operation is irreversible. Do not make a mistake! 
 
 
Importing Time Stamps from the USB-Key 
 
After copying the Time Stamps from the TIMY Terminal onto the USB Key, insert the Key 
into the PC, and click on the Control Panel button "Get Clocking Data". 
 
From software version v.149, TIMY-Soft 
prevents the importation of Time Stamps from 
the USB Key if the Calendars were not 
extended when the application was opened. If 
this is the case, the message on the right 
appears: 
 
Follow the instructions, and then select the 
Control Panel button "Get Clocking Data".  
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TIMY-Soft now transfers the Clocking Data of each employee into the appropriate 
employee time sheet file. A message displaying the progress is displayed for each 
employee: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Depending on the number of employees and the number of "Time Stamps" to be 
transferred and the computer speed, this operation can take between a few seconds to 
several minutes.  
 
When the transfer from the USB-Key is finished, TIMY-Soft automatically erases the 
contents of the Time Stamp file on the USB-Key, making it ready to use again. 
 
If a second attempt to repeat the transfer operation of Time Stamp data is made (where 
the USB-Key file is now empty) TIMY-Soft displays: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If TIMY-Soft does NOT find a Time Stamp file on the USB-Key the following appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Check that the USB-Key is connected correctly and that Windows® has recognised it by 
selecting "My Computer" on the PC Desktop display and reviewing the disks found by the 
operating system. Verify that a removable disk with the label "BKS" is present.  
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The drive letter "F:" may not be the same as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
New Records 
 
This worksheet is used for temporarily storing Time Stamps while they are imported from 
the UB-Key during the 'Get Clocking Data' routine. The "New Records" tab disappears from 
view whilst the data is imported. 
 
If TIMY-Soft cannot place Time Stamps into a Time Sheet they are saved in the "New 
Records" worksheet, and the reasons are: 
 
1. "Date non-existent in Time Stamp File": a date line for a Time Stamp does not exist in 
the employee Time Sheet. Example: TIMY-Soft has an Employee registered with the 
"Start-Date" 03/05/2013 but a Time Stamp exists for an earlier date. 
 
Solution: Delete the Employee using the Control Panel button 'Delete Employee'. Re-
register the Employee with 'New Employee' ensuring that the 'Start-Date' is the same date 
as (or earlier than) the first Time Stamp listed in the "New Records" tab. Disconnect the 
TIMY USB-Key, and select 'Get Clocking Data' in the Control Panel. The Time Stamps will 
now be imported from 'New Records'. 
 
2. "More than 10 Time Stamps": an employee has "Clocked-in" or "Clocked-out" more 
than 10 times in one day.  
 
Solution: Modify the employee Time Sheet to reflect the last Time Stamp shown in this list 
in order to capture the complete work presence. 
 
3. "Time Stamp already exists": an identical time stamp, measured to 1 second, has 
already been saved in the Employee time sheet. This is due to identical data being re-
imported, possibly as a result of a "BKS_FILE.TXT" file from a remote site being used a 
second time, or a copy of "BKS_FILE.TXT" existing in the Timy-Soft directory. 
 
Solution: The time stamps are redundant and should be cleared by using the 'Delete' 
button at the top of the worksheet. NOTE: Ensure that any valid Time Stamps are 
imported by using 'Get Clocking Data' as all records are deleted from "New Records" with 
the 'Delete' function. Delete the file "BKS_FILE.TXT" from the Timy-Soft directory. 
 
4. "Unknown Badge Number": the ID-Badge number for a Time Stamp cannot be found in 
the "Employee List", or the Employee is not registered in the "Employee List", or "0" 
(zero) may have been entered instead of letter "O" during data entry, or "1" may have 
been entered as letter "I" during data entry. 
 
Solutions: (a) Modify the employee ID-Badge number, or (b) Register the missing 
employee, or (c) Close and re-open TIMY-Soft and select "Yes" to 'Extend Calendars'. 
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With each new selection of "Get Clocking Data" TIMY-Soft attempts to load Time Stamps 
that are saved in the "New Records" worksheet tab. 
 
SPECIAL NOTE: If the "New Records" worksheet has a large number of errors, the TIMY-
Soft.xls application file grows significantly and the application operation speed can be 
impaired, particularly when importing Time Stamps from the USB-Key. The "New Records" 
worksheet must be periodically checked and the errors removed using the 'Delete' button 
in the "New Records" worksheet. All records in the "New Records" worksheet are 
deleted with this function and will not be found in the Windows Recycle Bin. 
 
 
Replacing a Lost ID-Badge 
 
Occasionally an Employee will report a lost badge, and will be unable to clock-in or clock-
out.  
 
Before a new badge is issued and used, the System Administrator should take a data 
download from the TIMY Clock Recorder with the USB Key and upload it to the TIMY-Soft 
application.  
 
A new badge can now be issued to the Employee by using the Control Panel soft-key 
'Modify Employee' and the Employee can now use the new ID-Badge as before. 
 
In the event that a data download has not been taken and the Employee has already 
swiped the new badge, the following action should be taken:  
 
1) If the Employee Badge No. has already been modified to the new badge number, the 

Time Stamp records for the old badge number will not be imported into the Time 
Sheet, but will be stored in the "New Records" worksheet tab. 

2) After importing the USB Key data, change the Employee Badge No. back to the old 
badge number and re-run 'Get Clocking Data' at which point the old badge Time 
Stamps will be imported to the Time Sheet. 

3) Modify, once again, the Employee Badge No. to the newly issued badge number. 
4) If the Employee has already started using the newly issued badge before the Employee 

Badge No. has been modified, take a download of the USB Key data and import the 
Time Stamps with 'Get Clocking Data'. 

5) Now modify the Employee Badge No. to the newly issued badge number, and click on 
'Get Clocking Data' again. This will ensure than any Time Stamps recorded with the 
newly issued badge will also be imported into the Employee Time Sheet.  

 
Re-using an ID-Badge previously issued to an Employee 
 
Whenever an employee departs from the company it is good practice to ask for the TIMY-
System ID-Badge, and the Employee Record should be modified (or deleted entirely). 
 
1) Using the TIMY-Soft Control Panel soft-key 'Modify Employee', change the Family 

Name to be preceded by the letter 'Z' then a space. This sorts the Employee to the 
bottom of the Employee List. 

2) Change the Badge No. to a virtual badge number, such as 0001. 
3) Place the retained ID-Badge back into stock for future use. 
 
Note: 
Time Sheets are not created according to Badge Numbers but are based on Employee Numbers. This 
can be verified by opening the computer directory where TIMY-Soft is installed (usually C:\BKS). 
There are a number of files with the name of 'point_1234.xls' where '1234' corresponds to the 
Employee Number as displayed in the Employee List. 
 
The Badge Number is used by the software only at the time that data is uploaded to TIMY-Soft from 
the USB Key. Clocking-in data is saved to specific Employee Time Sheets according to the Badge 
Number recorded against an Employee Number. 
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Data Back-up 
 
During the transfer of Time Stamps from the USB-Key to the computer, TIMY-Soft 
performs an automatic copy of the clocking data into a file in the directory in which TIMY-
Soft is installed. These files are named "histo_yymm.txt" where "yymm" refers to the year 
and the month of the transfer from the USB-Key to the PC.  
 
NOTE: This does not necessarily mean the month that the Time Stamps were made - it 
means the date of the transfer action. If Time Stamps of April 2015 are transferred on 01 
May 2015, they are saved in the file "histo_1505.txt" and not in the file "histo_1504.txt". 
 
The "histo_yymm.txt" files offer an added level of data security and permits the rebuild of 
the Time Stamp data if a major catastrophe were to occur with the Excel files or the 
computer. These files must be included in any the regular "TIMY-Soft" Backup routine. 
 
 
Time Sheets Back-up (from version 1.58) 
 
From version 1.58, TIMY-Soft has a built-in function for automatically backing-up the 
Employee Time Sheet files into a sub-directory named "Backup", located in the Timy 
system folder (default C:\BKS). This backup is made when the "Extend Calendars" 
function is used, and is a copy of the most recent version of the Employee Time Sheets, 
prior to the Extend Calendar action. 
 
In order to protect the TIMY-Soft 'system' files, users are still advised to make regular 
Backup copies of the Directory in which TIMY-Soft was installed, preferably onto a media 
different than the computer hard disk (e.g.ZIP-Disk, CD-ROM, or USB Memory) but NOT 
the TIMY USB-Key.  
 
Backup & Restore routines are also available for creating archive copies of files within MS-
Windows® Operating Systems. 
 
 
Restore Time Stamp Data (from version 1.58) 
 
In the event of PC crashes where time stamp 
data may have been lost or corrupted, it is 
now possible to easily restore previously 
backed-up time stamps from the Timy-Soft 
'history' files, effective from version v.158 
onwards.  
 
1. In the "Employee List" screen, select the 

name of the Employee that you wish to 
apply restored data, in our example Peter 
REEVES, and in the "Control Panel" chose 
"Modify Employee". 
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2. When                        is selected an information 
message is displayed. If 'Yes' is chosen, all Time 
Stamps will be imported from any available 
Timy-Soft 'history' files and saved into the "New 
Records" tab. 

 
3. If 'No' is selected the restore function is cancelled  

and the "Modify Employee" menu is removed. 
 
4. When completed, the restore function will 

display the message on the right.  
 

5. Select 'OK' to clear the message, returning 
control to the "Employee List" display. 

 
 
Repeat from item 1 on page 36 for any other Employees requiring "Restore Time Stamp 
Data". 
 
6. When all data has been recovered, select the tab "New Records" at the bottom of the 

"Employee List" and observe information similar to the image below: 
 

 
 
 
7. The data is likely to be much more than is required to correct errors on the related 

Employee Time Sheets, and filtering must be made by selecting  
 
8. The filter menu opens, shown on the 

right, where dates to be deleted can 
be chosen, leaving only the time 
stamp data that is required to restore 
the Employee Time Sheet(s). 

 
9. Select "Go!" when dates have been 

entered. If NO dates are entered a 
warning message will be displayed. 
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10. A confirmation message will be displayed when valid 

dates have been entered and "Go!" is selected. 
Select 'Yes' to proceed.  

 
 
 
11. The restored data for the remaining dates will remain in the "New Records" display. 
 
12. Return to the "Employee List", ensure the TIMY USB-Key is NOT connected and select 

"Get Clocking Data" on the "Control Panel". 
 
13. The message on the right will be displayed.  

Select 'Yes' to proceed. 
 
 
 
 

 
14. After importing time stamps from the "New Records" 

the following message might be displayed if Timy-
Soft detects that identical Time Stamps already exist 
in Employee Time Sheets. 

 
 
 
 
15. If the message in step 14 is displayed return to the "New Records" tab and repeat 

steps 8-10 for all the dates displayed to remove redundant data from the file. 
 

 
NOTE: The time stamp data restore function can only be applied to individual Employee 
Time Sheets, via the Control Panel "Modify Employee" function. It cannot be applied to all 
Employee Time Sheets in a batch mode. 
 
 
Terminate and Exit from TIMY-Soft 
 
To leave the application, close the "TIMY-Soft" Workbook by clicking on the      in the top 
right of the Excel window, perform the Excel "File > Close" commands or use Alt+F4. 
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APPLICATION SOFTWARE 
TECHNICAL SUPPLEMENT 

 
 
About the USB-Key 
 
Precautions are taken to prevent unauthorised individuals from using any commercially 
available USB-Key to remove Time Stamp data from the Time Reporting Terminals. 
 
The Time Stamp data is stored on the USB-Key in a text file named "BKS_FILE.TXT". This 
file is pre-installed on the USB-Key before delivery to customers. NEVER MODIFY the 
name of this file, NOR REMOVE it from the Key. If the content of the USB-Key is tampered 
with in any way, or if an unauthorised USB-Key is used, the Time Reporting Terminal 
rejects the Key with an error message (e.g. "Er65") and Time Stamps cannot be 
transferred to the USB-Key. 
 
If ever the TIMY USB-Key becomes unusable due to error messages, or a commercially 
available USB-Key is obtained to use with the TIMY-Soft application, follow these 
procedures to initialise the USB-Key. 
 
 
Format the USB-Key on the Time Recorder 
 
Time Recorders from serial number 05N6 onwards have an embedded routine to re-
initialise the TIMY USB-Key. The routine is encoded into the Time Recorder firmware and 
requires the use of the TIMY Management Badge "INIT USB KEY", provided with the TIMY-
System. 
 
NOTE: Initialising a USB Key with the TIMY terminal DELETES ALL FILES stored on 
the key, and REDUCES THE MEMORY CAPACITY TO 128 MB, independent of the actual 
memory capacity of the key. If a key is purchased with 8GB capacity and is initialised with 
the TIMY terminal, the key capacity is reduced to 128MB. There is NO WAY to cancel this 
operation to recover the full capacity. 
 
To prevent unintentional loss of Time Stamp data on the USB-Key, if the terminal detects 
there is a Time Stamp file (BKS_FILE.TXT) containing data, the initialisation process is 
terminated. If a Time Stamp file exists but is empty, the initialisation process continues. 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: Re-initialisation with the Time Recorder unit can only be performed with the  

 "INIT USB KEY" badge on units from serial numbers 05N6, and onwards 
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INIT USB KEY Procedure 
 
On the TIMY Time Recorder unit press the red button and  
swipe the "INIT USB KEY" badge. The display indicates  
In ıt and the TIMY unit is ready to re-initialise the USB-Key. 
 
 
 
 
Within 5 seconds, connect the TIMY USB-Key. The message 
USb ı is displayed for about 5-6 seconds.  
 
 
 
Do not remove the USB-Key until the message changes to 
End. If time stamps are ready for download, leave the  
USB-Key connected and press the red button. 
 
 
 
Error conditions that may occur during initialisation 
 
Er03  May occur after swiping the initialisation badge. The Time Recorder is an earlier 

version that cannot be used to initialise the USB-Key. Use the PC procedure 
described in the next section to format the USB-Key on the PC. 

 
Er81 There is a time stamp file (BKS_FILE.TXT) containing data on the key, and the 

initialisation is cancelled. Empty the file first by transferring the USB-Key data into 
the TIMY-Soft application with "Get Clocking Data". 

 
 
Format the USB-Key on the PC 
 
If ever the TIMY USB-Key becomes unusable due to error messages, or a commercially 
available USB-Key is obtained to use with the TIMY-Soft application, follow these 
procedures to initialise the USB-Key. 
 
NOTE: USB-Keys must have 2GΒ nominal storage capacity, or less, when formatting on 
the PC. Larger capacity keys cannot be formatted with this method on a PC for use with 
the TIMY-System. 
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1) On the PC desktop display select "My Computer" and click on the icon corresponding to 
the USB-Key with the right mouse button, then select "Format ..." 

 
 
 
  DO NOT MODIFY the "Capacity" field 
 
 

  Select FAT as File system (NOT FAT32) 
 

  Allocation unit size cannot be changed 
 
  Enter BKS as Volume Label (in CAPITAL LETTERS)  
 
 
  DO NOT SELECT Quick Format 
 
 
 
 

 
  Click on "Start" and confirm "OK" in the next message 
 
 

 
 
2) Start "MS-Notepad", normally found under "Programs > Accessories", and create an 
empty file named "BKS_FILE.TXT" (all in CAPITAL LETTERS) in any directory on the PC's 
hard disc. Remember the location, close MS-Notepad and copy the file just created onto 
the USB-Key. 
 
VERY IMPORTANT: Do not save the "BKS_FILE.TXT" file directly from Notepad onto the 
USB-Key. It must first be stored on the PC and then copied to the USB-Key. 
 
 
Receipt of Time Stamps from a Remote Site 
 
If a remote work site is operated where a TIMY Terminal is installed, it may be time 
consuming or inconvenient to receive the physical USB-Key from the site. 
 
A copy of the Time Stamp File ("BKS_FILE.TXT") on the USB-Key can be sent by e-mail. 
Alternatively, copy the file to another USB memory key and mail it to the location where 
the TIMY-Soft Time Reporting Application is operated. 
 
IMPORTANT: After this operation, the contents of the file "BKS_FILE.TXT" on the remote 
site USB-Key must be erased. If the file is not erased, the same data are re-transmitted at 
the next time reporting period. Double-click on "BKS_FILE.TXT" located on the USB-Key. 
Windows® opens the file with MS-Notepad. Click on "Edit > Select All", then press the PC 
"Delete Key" or click on "Edit > Delete". Now SAVE the empty file, but do NOT use "Save 
as . . . ". 
 
DO NOT DELETE THE FILE ON THE USB-KEY OR REPLACE IT BY AN EMPTY FILE.  
 
The TIMY Terminal would subsequently not be able to transfer Time Stamps to the USB-
Key, and will display "Er65" when attempting to transfer Time Stamps. 
 
On the computer running the TIMY-Soft Application, copy the "BKS_FILE.TXT" file from the 
remote site into the directory containing the TIMY-Soft files. There may already be a blank 
file with the same name in which case over-write the blank file.  
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Ensure that there is no USB-Key inserted in the PC and in the TIMY-Soft Control Panel 
select "Get Clocking Data". TIMY-Soft will not detect a USB-Key and it will search the local 
directory for a "BKS-FILE.TXT" file. If one exists in this directory, and it contains Time 
Stamps, TIMY-Soft will import the file data as if it were from a USB-Key. 
 
If this "Remote Data" capability is used, it is very important to: 
 
- NEVER delete the "BKS_FILE.TXT" file on a USB-Key 
- NEVER modify the name of the "BKS_FILE.TXT" file on a USB-Key  
- ALWAYS make a backup copy of the "BKS_FILE.TXT" file at the remote site in case 

there is a problem when sending the file to the TIMY-Soft operating location. 
 
 
Customer-Specific calculations 
 
In the employee Time Sheets the twenty columns AR-BK are available for calculations of  
commonly used functions, such as: 
 
- Standard overtime 
- Sunday hours 
- Night hours 
- Compensation rest hours 
 
It is also possible to calculate new Daily Totals, if the standard totals are not appropriate 
e.g. if it is required implement a system of midday breaks with a minimum deduction, or to 
display totals in Hours and Minutes instead of Hours and Decimals. 
 
CAUTION: In order to avoid any confusion, never use the same column for different 
formulas from one employee to another e.g. do not use the column AR for Overtime for 
Mr. Bridges, and the same column for Night Hours for Mr. Parkes. 
 
Unfortunately, Excel does not permit the unlocking of the "Format" function of individual 
cells when the whole worksheet is protected, as it is in TIMY-Soft. If there is need to 
change the format of a cell in columns AR-BK, use "Copy > Paste" from an already 
formatted cell. 
 
If the format of one of the cells in the Time Sheet is suitable, simply "Copy" this cell and 
select the Cell(s) in the column to be modified. Now click on "Edit > Paste Special" and 
select "Formats" before clicking on "OK", shown below: 
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If none of the cells in the Time Sheet have the format required, open a new file in Excel 
with "File > Open" whilst TIMY-Soft is running, and customise a cell in the new file as 
desired. Perform a "Copy" of this customised cell with "Edit > Copy" and then return to 
the Time Sheet WITHOUT CLOSING THE NEW FILE and proceed to "Paste" the format to 
the desired cells as described above.  
 
Once the cells with the desired format are in the Time Sheet, "Copy > Paste" these 
without going back to the New File. After the "Format" of a cell is copied from the New 
File, it can be closed without saving. 
 
To modify the width of any one of the free columns AR-BK, click in the title cell (e.g. AR7) 
with the RIGHT mouse button to set column width as required in the menu shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Calculation 1: Midday break with minimum deduction 
 
A minimum time deduction has to be setup for the midday break (in this example, 1 hour) 
without obliging the employees to leave the workplace and return in precisely 1 hour. If 
employees leave at midday for LESS than 1 hour, then 1 hour is deducted. If employees 
are absent for MORE THAN 1 hour, the system deducts the actual duration. The formula 
used assumes that employees "clock" their lunch break departures and arrivals. 
 
If employees "Clock-out" at 12:07 and "Clocks-in" at 12:58, the actual duration of the 
break is 51 minutes or 0.85 hour. The time deduction is 1.00 hour. 
 
If employees "Clock-out" at 13:35 and "Clock-in" at 14:15, the actual duration of the 
break is 40 minutes or 0.67 hour. The time deduction is 1.00 hour. 
 
If employees "Clock-out" at 12:07 and "Clock-in" at 13:10, the actual duration of the 
break is 1hour and 3 minutes (or 1.05 hours). The time deduction is 1.05 hour. 
 
The column "Net Hours" cannot be modified because it is related to complex formulas 
elsewhere in the system and is therefore protected. Use one of the available unlocked 
columns to the right of "Total Week" (column AR, AS, etc) for a new "Total". It is 
necessary to format the cells of this column like a "Number" with 2 decimals (see above to 
copy the format of one cell in Column T). 
 
The Excel formula in this calculation uses the functions IF and AND. If the user is not 
familiar with these functions, consult the Excel online help and the following discussion will 
then be easier to understand. 
 
Internally, Excel represents time in hours as a fraction of a day, so if a Time Stamp 
appears as 12:00 noon, the actual underlying numeric value is 12/24 = 0.5. Similarly, 
08:00 is actually 8/24 = 0.33333, etc. Therefore, to represent a time of day as hours in 
numeric form, it is necessary to multiply by 24. 
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For example, if the cell C10 contains "08:00" and the cell D10 contains "12:00", the 
formula "=D10-C10" does not produce "4.00", but "0.17" (0.5 minus 0.33). To obtain 
"4.00" the formula is "=(D10-C10)*24". 
 
We base our formula on the daily total calculated by TIMY-Soft in column T, and apply a 
negative correction if the duration of the lunch break was less than 1 hour. The formula, in 
this example for line 13, is: 
 

=IF(AND(D13>0,E13>0),IF((E13-D13)*24<1,T13-(1-(E13-D13)*24),T13),T13) 
 
Translation: IF there is a Time Stamp in column D AND there is also one in column E 
(which would normally indicate that the employee "clocked" a lunch break), then the 
calculation is performed – otherwise use the existing value in column T. This test is 
necessary to prevent the formula from deducting a 1-hour lunch break on days for which 
there are no Time Stamps at all (e.g. Saturdays and Sundays) or on days when the 
employee was only present during the morning or only the afternoon. The calculation is 
located in the middle of the formula: 
 

IF((E13-D13)*24<1,T13-(1-(E13-D13)*24),T13) 
 
Translation: IF the Time Stamp in column E minus the Time Stamp in column D 
(multiplied by 24) is less than 1 hour, it is necessary to make a correction to the hours 
calculated in column T. This correction corresponds to the difference between the actual 
"Time Stamp-duration" of the midday break and 1 hour, expressed as 1-(E13-D13)*24. 
 
This correction is deducted from column T. When the formula is entered in one cell "Copy 
> Paste" it into the other cells of the column (Excel automatically adjusts the line numbers 
when "Copy > Paste" is used for formulae).  
 
An example of the result is:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The formula is in column AR. On the dates 03/12 and 04/12 the duration matches the "Net 
Hours" value because there is no midday break on these days. 
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On 05/12 the length of the midday break is (12:49 - 12:03 = 46 minutes or 0.77 hours) 
and the calculation needs to deduct 0.23 hour from column T to make a corrected daily 
total of 4.97 hours. 
 
On the date 08/12 the length of the midday break is 1 hour and 4 minutes and a 
correction is not necessary. The value in column T is now copied to column AR. 
 
In this situation where a new daily total is calculated, the user may not wish to display 
columns M, T and AQ since these could lead to confusion. Hide these columns by clicking 
on a column title with the RIGHT mouse button and uncheck the columns concerned. 
 
If the Total for column AR 
should be displayed at the 
bottom of the Time Sheet, 
RIGHT mouse click on one of 
the cells containing the 
formula. 
 
This opens the menu on the 
right. Select "Generate a 
Subtotal for this column".  
 
If the formula will always be 
applied to this employee, 
check the box "Use the 
formula and format of the 
active cell as default". 
 
 
 
Check the box "Generate a Subtotal for this column" to: 
 
-  create a Subtotal for this column, when the Time Sheet is saved on closing 
-  include the column title in the "Summary" report 
-  include the Subtotal in the "Summary" report 
 
Check the box "Use the formula and format of the active cell as default" if the formula is 
to be always applied to this employee. This formula is then written into all new date lines 
when the TIMY-Soft calendar is extended. Future date lines in this Time Sheet will 
automatically include this new formula. 
 
This operation has no effect on other employees' Time Sheets. If the same formula has to 
be applied to other employees, copy the formula into each employee Time Sheet. 
 
TIP: As only ONE Time Sheet can be opened at a time, it is not possible to simply "Copy 
> Paste" a cell from one Time Sheet to another (when a Time Sheet is closed Excel does 
not remember the last cell copied). To copy a formula from one Time Sheet to another, 
select the entire text of the formula in the Formula Bar at the top of the screen, and 
then perform a "Copy". Now press the "Esc" key to cancel the selection, otherwise the file 
cannot be closed. Close the Time Sheet, open another one, and perform a "Paste" in the 
same cell (same column and same line). From here it is possible to "Copy > Paste" into 
the new Time Sheet. 
 
This formula can be extended to deduct a contractual break if the employee did not 
"clock" the midday break at all. Note that there are only two "clocking" events during the 
day and that the "Start 1" Time Stamp is (for example) before 10:00 and the "End 1" 
Time Stamp is after 15:00. 
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The necessary conditions here would be for the cell in C to be greater than 0 but less than 
10/24, and for the cell in D to be greater than 15/24, and for the cell in E to be =0 (i.e. 
only TWO Time Stamps – the first before 10:00 and the second after 15:00). 
 
It is now easy to replace the "FALSE" part in the previous formula, which is the last cell 
(T13) on the right: 
 

=IF(AND(D13>0,E13>0),IF((E13-D13)*24<1,T13-(1-(E13-D13)*24),T13),T13) 
 
by the new condition: 
 

IF(AND(C13>0,C13<10/24,D13>15/24,E13=0),T13-1,T13 
 
Translation: IF the condition is true, then let the value of this cell equal T13 minus 1 hour, 
otherwise let it be equal to T13. The entire formula is: 
 

=IF(AND(D13>0,E13>0),IF((E13-D13)*24<1,T13-(1-(E13-D13)*24),T13), 
IF(AND(C13>0,C13<10/24,D13>15/24,E13=0),T13-1,T13) 

 
ALL three situations that could arise are calculated. If employees "clock" at midday for less 
than one hour, one hour is deducted. If employees "clock" for more than one hour, the 
actual "clocked" duration of the break is deducted. If employees do not "clock" at all at 
midday, the default time of one hour is deducted. 
 
 
Calculation 2: Overtime 
 
Assume that THREE rates of overtime are paid: 
 
Rate 1 – 10% for working between 40 hours and 44 hours per week 
Rate 2 – 25% for working between 44 hours and 48 hours per week 
Rate 3 – 50% for any working time more than 48 hours per week 
 
As a starting point use the "Total Week" column AQ (which derives its value from the last 
7 daily totals in column T). The number of hours subject to an overtime rate of 10% are 
calculated and entered in column AR, the hours with 25% rate go into column AS and the 
hours with 50% rate go into column AT.  
 
1) Calculate the hours beyond 48 hours (column AQ) with the following formula  

(here for cell AT168): 
 

=IF(AQ168>40,IF(AQ168>48,AQ168-48,0)," ") 
 
Translation: IF the "Total Week" value is larger than 40, the calculation is launched. If 
not, then the value of the cell becomes " " (the cell remains blank). "0" could also be 
used, but that would display many zeros for the other days of the week, and also for the 
weeks without overtime. 
 
Calculation: IF the "Total Week" value is larger than 48, the value of the cell is the 
"Total Week" minus 48. If not, then the value of the cell is "0". In this case do not use " " 
because the result created by this cell is used in formulae of other cells, and " " is not a 
valid number for Excel. 
 
2) Calculate the hours with 25% overtime rate (column AS) with the following formula 

(here for cell AS168): 
=IF(AQ168>40,IF(AQ168>44,AQ168-44-AT168,0)," ") 

 
Translation: IF the "Total Week" value is larger than 40, the calculation is performed. If 
not, then the value of the cell becomes " " (cell remains blank). 
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Calculation: IF the "Total Week" value is larger than 44, the value of the cell is the 
"Total Week" value minus 44, minus any calculated hours with 50% overtime rate. If not, 
then the value of the cell is "0". 
 
3) Finally, calculate the hours with 10% (column AR) with the following formula  

(here for cell AR168): 
 

=IF(AQ168>40,AQ168-40-AS168-AT168," ") 
 
Translation: IF the "Total Week" value is larger than 40, the calculation is performed. If 
not, then the value of the cell becomes "" (cell remains blank). 
 
Calculation: IF the "Total Week" value is larger than 40, the value of the cell is the 
"Total Week" minus 40, minus any calculated hours with 25% overtime rate and minus 
any calculated hours with 50% overtime rate. If not, then the value of the cell becomes "" 
(cell remains blank). 
 
The three cells must be copied down into the other cells of their respective columns, and 
we get Subtotals and the formula by default. Example of the result: 
 

 
If the Subtotals are requested, Column Labels also appear in the "Summary" report when 
the Control Panel "Show Summary" is selected. 
 
 
Calculation 3: Night Work 
 
In some cases there be a requirement to measure any work time within a certain 
timeframe, typically at night because it is often subject to a bonus payment. 
 
The formula for this calculation uses the functions IF, OR and AND. If the user is not 
familiar with these functions, consult the Excel online help and the following discussion will 
then be easier to understand. 
 
The example below assumes that there are 2 or 4 Time Stamps recorded. If employees 
also take rest breaks it are necessary to extend the formulas to Start 3 - Stop 3 and 
possibly to Start 4 - Stop 4. This example assumes that Night hours are between 22:00 
and 04:00 on the following day. 
 
Internally, Excel represents time in hours as a fraction of a day, so if a Time Stamp 
appears as 12:00 noon, the actual underlying numeric value is 12/25 = 0.5.  
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Similarly, 08:00 is actually 8/24 = 0.33333, etc. Therefore, to represent a time of day as 
hours in numeric form, it is necessary to multiply by 24. 
 
To determine if a Time Stamp is before or after 04:00, it must be compared with the 
fraction "4/24". And, to determine if it is before or after 22:00, it must be compared with 
the fraction "22/24". Instead of using fractions converted to decimal form (which involves 
some rounding errors), we use the values "4/24" or "22/24". It is actually more precise, 
and more readable. Sequence of the tests: 
 
1) Is the "Start 1" Time Stamp >04:00 hours and <22:00 hours, and is the "Stop 1" Time 

Stamp >04:00 hours and <22:00 hours ?  
 
If the answers to these FOUR conditions are all "Yes" the Night Work test for "Start 1 & 
Stop 1" halts, because there are not any Night Work hours in this period. If the response 
to at least ONE of these questions is "No", then all or part of the period is categorised as 
Night Work, and the formula proceeds to the next step. 
 
In the formula, this is tested in the following way (assuming the formula is on line number 
133 of the Time Sheet): 

 
IF(AND(C133>4/24, C133<22/24, D133>4/24, D133<22/24),0, . . 

 
Translation: IF the Time Stamp in "Start 1" (column C) is AFTER (>) 04:00 hours, AND 
the Time Stamp in "Start 1" (column C) is BEFORE (<) 22:00 hours AND the Time Stamp 
in "Stop 1" (column D) is AFTER (>) 04:00 hours, AND the Time Stamp in "Stop 1" 
(column D) is BEFORE (<) 22:00 hours, then the condition is TRUE. The calculation 
results in the value "0" (no Night Work during this period).  
 
2) If the condition is FALSE, determine the time used for the END of the Night Work  
 
It is either Time Stamp "Stop 1", or 04:00 hours. If "Stop 1" is before 04:00 or after 
22:00 then the employee stopped working during the Night Work period and the end-point 
are equal to "Stop 1". This would be the case if the employee stopped at 23:15 or at 
03:07 for example. If the employee stops working outside of the Night Work period, that 
is, after 04:00 and before 22:00, then the end-point must be equal to 04:00. 
 
The part of the formula that carries out this test takes the form:  
 

. . . IF(OR(D133<4/24,D133>22/24),D133,"04:00"))- . . . 
 
Translation: IF the Time Stamp in column D is BEFORE 04:00, OR the Time Stamp in 
column D is AFTER 22:00 then the Time Stamp value in column D is used for the end of 
the period. In any other case, 04:00 is used. 
 
3) Determine which time value is used for the BEGINNING of the Night Work period, and 

then SUBSTRACT the end-point value determined in the preceding stage. The start-
point can be EITHER the Time Stamp "Start 1", OR 22:00. 

 
If "Start 1" is <04:00 or >22:00 the start-point for calculation of Night Work hours is 
"Start 1". If the employee starts to work during the day then the start-point for Night 
Work hours must be 22:00. 
 
The part of the formula that carries out this test takes the form: 
 

. . . -IF(OR(C133<4/24,C133>22/24),C133,"22:00"))+ . . . 
 
IF the Time Stamp in the column C is BEFORE 04:00, OR the Time Stamp in the column C 
is AFTER 22:00 then the Time Stamp value in column C is used. In any other case 22:00 
is used. 
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 This completes the calculation for the first period. If the employee clocks 4 times (two 
work periods) a similar formula must be established for the second period, and added to 
the first part: 
 
+IF(AND(E133>4/24,E133<22/24,F133>4/24,F133<22/24),0,IF(OR(F133<4/24,F133>22
/24),F133,"04:00")-IF(OR(E133<4/24,E133>22/24),E133,"22:00")) 
 
The complete formula assigned to cell AR133 is: 
 
=(IF(AND(C133>4/24,C133<22/24,D133>4/24,D133<22/24),0,IF(OR(D133<4/24,D133
>22/24),D133,"04:00")-IF(OR(C133<4/24,C133>22/24),C133,"22:00"))+ 
IF(AND(E133>4/24,E133<22/24,F133>4/24,F133<22/24),0,IF(OR(F133<4/24,F133>22/
24),F133,"04:00")-IF(OR(E133<4/24,E133>22/24),E133,"22:00")))*24 
 
The cell must be formatted as a "number" in order to have time in tenths and hundredths.  
 
Enter the formula in one of the cells of the free column by replacing "133" with the line 
number where the formula are placed.  
 
"Copy > Paste" the formula down to other cells in the same column. If a Subtotal is 
required, and is to be displayed in the "Summary" report, open the "Settings for 
unprotected columns" form by clicking with the RIGHT mouse button on the cell where the 
formula is entered and follow the procedure on page 41 of this manual. 
 
It are necessary to create the same formula for each employee Time Sheet for which Night 
Work hours have to be calculated. 
 
TIP: Since only ONE Time Sheet can be opened at a time, it is not possible to simply 
"Copy > Paste" a cell from one Time Sheet to another. When a Time Sheet is closed Excel 
does not "remember" the last cell copied.  
 
To copy a formula from one Time Sheet to another, select the entire text of the 
formula in the Formula Bar at the top of the screen, and then perform a "Copy". Now 
press the "Esc" key to cancel the selection (otherwise the file cannot be closed). Close the 
Time Sheet, open another one, and perform a "Paste" in the same cell (same column and 
same line). From here it’s possible to "Copy > Paste" into the new Time Sheet. 
 
 
Time format in Hours and Minutes 
 
If time calculations have to be displayed in the format "hh:mm", instead of fractional 
hours, proceed as follows. This example duplicates column T (Net Hours) into the free 
column AV, and change the format to "Hours and Minutes" instead of fractional hours, as 
displayed in column T. 
 
With an employee Time Sheet file open, also open a 
new Excel file. In the new file, set the Format of the 
active cell to "[h]:mm".  
 
This setting is available under "Format > Cells". 
Under the "Number" tab click on the "Custom" option 
in the list. Under "Type", select "[h]:mm:ss" and 
erase the ":ss". Do not use the standard "Time" 
format, as time values greater than 24 hours cannot 
be displayed with this format.  
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"Copy > Paste" the cell with this format into the Time Sheet column as explained 
previously. 
 
Assume that we are at the beginning of the Time Sheet in line 8, type the formula:  
=T8/24 in the cell and press "Enter" on the computer keyboard. The numbers in column T 
represent HOURS. As time is represented in Excel as a fraction of a day, we divided by 24. 
 
Place the mouse cursor over the cell in the first row of the column and press the RIGHT 
mouse button. The "Settings for unprotected columns" menu opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To copy the formula in line 8 into all the lines below in the same column and create a 
subtotal, check "Generate a Subtotal for this column" and check "Use the formula and 
format of the active cell by default" as shown above. This formula is automatically copied 
into new date lines when the TIMY-Soft calendar is extended. 
 
The result is: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Column AR takes the values of column T and converts it to the format "Hours and 
Minutes". A Subtotal value is created at the bottom of the hourly figures in column AR. In 
the example above we have applied a similar procedure to column AS ("Total Week").  
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In order to avoid zeros or errors in those lines in which the weekly total is blank, the 
formula used is: 

=IF(AQ8>0,AQ8/24," ") 
 
To avoid confusion, it is recommended that columns M, T and AQ be hidden so that only 
the durations in "Hours and Minutes" are displayed in Columns AR and AS.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If Subtotals for a column are selected, these are automatically included in the "Summary" 
report worksheet, and with the same time format. 
 
 
Rounding and Truncating in Excel 
 
It may be thought that there are minor errors in the calculations, as in the example below, 
where the duration between 08:00 and 12:00 is indicated as 4.02 hours in decimal 
format, and 4:00 in hours:minutes format. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
These are NOT errors, but are the effects of the Excel rounding and truncating for display 
purposes. 
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The Time Reporting Terminal generates the Time Stamps in Hours, Minutes and Seconds, 
but the Seconds in the Time Sheets are not be seen because the cell formats are specified 
as "hh:mm" (seconds are truncated for display purposes).  
 
In the previous example, the Time Stamp "08:00" is actually "08:00:11" and the Time 
Stamp "12:00" is actually "12:00:48". The total of 59 seconds corresponds to 0.01639 
hours, which is rounded-up by Excel to .02 in the "Net Hours" cell with two significant 
digits after the decimal point. 
 
The representation of time duration in decimal form is more precise than the displayed 
hours:minutes in which there is no rounding. There is no need for concern because 
internally Excel always uses up to 15 significant digits to calculate numeric values 
(whether they are time related or other numbers). There is no risk of compounding 
rounding or truncation errors in long lists of sums. 
 
In the previous example, the 3 days worth of 59 seconds corresponds to exactly 
0.0491666666666666666666666666666667 of an hour, which is rounded up to 0.05 by 
Excel, but is truncated to 2 minutes in hours:minutes form. The actual value is 2 minutes 
and 57 seconds. 
 
In summary, whichever way is chosen to display time, the employees' weekly, monthly or 
yearly totals are always correct to within 0.01 hour in decimal form and 1 minute in 
hours:minutes form, and calculate their clocking times to the second. 
 
 
Problem resolution 
 
1) The USB-Key is connected and "Get Clocking Data" is selected, but TIMY-Soft 

displays: 
 
 
 
 
 
 
 
 
 
Probable reason: MS-Windows® cannot detect the presence of the USB-Key. Unplug the 
Key and plug it in again. Try again to use "Get Clocking Data". If Windows®98 operating 
system is installed, ensure that the Driver for the USB-Key is installed. If another 
operating system is installed, shut down and re-start the computer. 
 
2) During the start-up of TIMY-Soft this message is displayed: 
 
 
 
 
 
 
 
 
 
 
Reason: The file name "TIMY-Soft.xls" has been modified, or changed. This can happen if 
the Excel command "Save as..." is used AND a different name was specified. NEVER 
perform "Save as..." with another name, and NEVER change the names of any of the 
TIMY-Soft application files. Exit the application, change the name of the file back to "TIMY-
Soft.xls" and re-start the application. 
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DO NOT move the TIMY-soft.xls file to the "Desktop" display of the PC. A shortcut can be 
created to allow TIMY-Soft to start from the "Desktop" display.  
 
Open Windows Explorer® (or go via "My Computer") and click on the file "TIMY-Soft.xls" 
with the RIGHT mouse button. Click on "Send to > Desktop (create shortcut)". DO NOT 
MOVE the "TIMY-Soft.xls" file from the installation directory. 
 
3) During the start-up of TIMY-Soft, Excel displays a macros warning message, 
such as: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Reason: This is a general Excel warning for any files containing programmable 
instructions, such as those used in TIMY-Soft. Since the source of the TIMY-Soft 
programme is legitimate click on:  
 
 
 
 
If the Excel macro protection is set to "high" or "very high", Excel may not  indicate a 
message at all (depending on the version) and will not activate the macros. In this case 
TIMY-Soft opens, but NOTHING WORKS - clicking on the buttons of the Control Panel has 
no effect, and the following message remains displayed: 
 
 
 
 
 
 
 
 
 
 
The macro protection must be disabled, as discussed in the Installation section of this 
manual. 
 
With the macro protection disabled, NEVER open Excel files if the source is unknown. 
Macros in MS-Office® documents may contain viruses that could damage the computer 
system. If in doubt about a particular file, temporarily set the protection to "Medium", 
then open the file. If it contains macros, there is a warning, and it is possible to decide 
NOT to enable the macros. 
 
IMPORTANT: TIMY-Soft cannot function if the Excel macros are disabled. 
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4) Time Stamps imported from the USB-Key appear twice or more and are 
displayed in the "New Records" worksheet tab 

 
Probable reason: The Anti-Virus software is set up to prevent the TIMY-Soft macros 
from erasing the contents of the Time Stamp File on the USB-Key after they have been 
imported into the Time Sheets.  
 
This issue has been observed with the some Anti-Virus Programmes, notably Kaspersky. 
The user must modify the settings of the Anti-Virus Software to allow: 
 
- the creation of new text files 

- writing into text files 

- erasing the contents of text files 
 
5) TIMY-Soft operations appear to take a long time 
 
Probable reason: This can also be due to the Anti-Virus software, and it has been 
observed with Norton Anti-Virus software from Symantec. If this Anti-Virus software is 
operational, disable the "Office Plug-in". 
 
Secondary Reason: The "New Records" worksheet has accumulated a large amount of 
redundant errors such as "Date non-existent in Time Stamp File", "More than 10 Time 
Stamps", "Time Stamp already exists" or "Unknown Badge Number". When the errors 
have been resolved (indicated dates help this situation), click on "Delete all" at the top 
right of the worksheet. Confirm the next message with "Yes”. This deletes all of the 
records in the worksheet. 
 
6) Other problems have been seen that prevent the use of TIMY-Soft correctly 
 
Before calling the TIMY-System supplier for help, verify the following: 
 
- All the TIMY files are installed on the local hard disk ("C:") of the PC.  
 
- If the PC is configured for multiple users, does the user of TIMY-Soft have read and write 
access to the directory in which the application is installed, and to the USB-Key? This 
situation can arise if the application was installed by the Administrator with full access, but 
TIMY-Soft is run by another user who does not have the same access rights. 
 
- Are all the TIMY-Soft files located in the SAME directory? After installing the files, it is 
possible to modify the name of the directory, or move ALL the files to another directory, 
but the files must NEVER be located in more than one directory. If a "Shortcut" on the 
Desktop is used to access the "TIMY-Soft.xls" file and the directory name is modified, 
delete the "Shortcut" and create a new one. 
 
- Is the user sure that she/he is working with ONLY ONE COPY of the TIMY-Soft 
application? Regular back-up copies of the TIMY-Soft files should be made, but users 
should only work with the original file versions. 
 
- Has the user invoked the "Tools > Protection > Protect and Share Workbook" function.  
 
WARNING: Do not use this function with the TIMY-Soft application. 
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Changing the PC 
 
If the TIMY-Soft application has to be transferred to another PC, simply copy the entire 
contents of the directory containing the TIMY-Soft files to the new PC. Create a New 
Directory on the new PC, containing ONLY the TIMY-Soft files. DO NOT mix the TIMY-Soft 
files with other files. 
 
Since another copy, or version, of Excel is working on the new PC, remember to set the 
macros of Excel correctly before opening the TIMY-Soft application (see page 7). 
 
 
Do’s and Don’ts 
 
1) Do not insert the USB-Key with the TIMY-Soft installation files into the Time Reporting 
Terminal before installing the files on the PC. The Terminal DELETES the files from the Key 
and it is not be possible to install the application. 
 
2) Do not install the TIMY-Soft files on a network server except in exceptional 
circumstances 
 
3) Do not rename any of the TIMY files 
 
4) Do not rename the installation directory after installation, unless the user is very 
experienced with Windows operating systems. 
 
5) Do not work on OTHER Excel files while the TIMY-Soft application is open. If it is 
necessary to work on other Excel files, close the TIMY-Soft application first. If other files 
MUST be open while keeping TIMY-Soft open, close the other files FIRST, and close the 
TIMY-Soft application LAST.  
 
6) Do not close Excel by clicking on the upper-most "X" in the top right-hand corner while 
TIMY-Soft Time Sheet workbooks are still open. 
 
7) Do not leave the USB-Key inserted in the PC permanently. As soon as Time Stamp 
data is imported (transferred), remove the Key and keep it in a secure place. 
 
8) Before starting TIMY-Soft the first time on the PC, or on a new PC after transferring the 
files, Do deactivate the Excel macro protection. Check the Time and Date formats set in 
the Windows® Configuration Panel. The Date MUST be set to "dd/mm/yyyy" format. 
 
9) If the TIMY-Soft application are started from the "Desktop" display of the PC, Do create 
a shortcut by clicking on the file "TIMY-Soft.xls" with the RIGHT mouse button and clicking 
on "Send To Desktop (create shortcut) ". Do NOT move the "TIMY-Soft.xls" file to the 
Desktop display. 
 
10) Do deactivate any protection mechanisms associated with MS-Office® if the PC is 
protected with Anti-Virus software. They may reduce performance, and they may also 
prevent TIMY-Soft from functioning correctly. 
 
11) Do not try to print the "Employee List" directly. There is a bug in Excel 2000 and 
Excel 2002, which may cause the TIMY Control Panel to be moved and some of the 
buttons to be hidden, if an attempt is made to print the "Employee List" with these two 
versions of Excel. Instead, Copy the range of cells of interest, and Paste them into a new 
File, then print the data from the new file. 
 
In the event that this problem occurs, please contact us and we will reset the Control 
Panel to its correct location. 
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Frequently Asked Questions 
 
1) The USB-Key data was imported into TIMY-Soft, but a message states "Some of the 

time Stamps could not be imported into the Details Files". 
 

Consult the "New Records" worksheet to resolve the errors (see page 34). 
 
 
2) The Time Sheets do not display the most recently imported Time Stamps.  
 

Verify that the Control Panel "Active Period" dates are set for the correct date period to 
be displayed. If the dates are set correctly, consult "New Records" to resolve the errors. 

 
 
3) An employee Time Sheet does not contain recently imported time stamps.  
 

Check the "New Records" worksheet. If there are Time Stamps with comments such as 
"Unknown Badge Number", check that all badge numbers are registered to employees. 
Consult the "New Records" worksheet to resolve the errors listed. 

 
 
4) TIMY-Soft runs very slowly, especially when importing Time Stamps from the USB-Key. 
 

Click on "New Records" worksheet tab. There may be many lines of error messages 
listed. Check the data for validity, then use the "Delete all" button, at the top right of 
the worksheet, if the data is to be cleared. 

 
 
5) When the USB-Key is connected to the TIMY Time reporting Terminal and the red 

button is pressed, the messages "Copy", "End" and "Er65" are seen. 
 

(a) The USB-Key format is corrupt, possibly by saving non-TIMY files on the key. The 
USB-Key must be re-formatted in order to clear this error. See pages 38-39. 

 
(b) On PCs with Windows 8 and Windows 8.1, the operating system writes a search 

indexing folder onto the USB-Key. The TIMY-Soft supplier can provide a Registry 
Patch file to prevent this file from being written. 

 
 
6) The TIMY Time Recorder unit displays "bAtt" when attempting to download time stamps 

data to the USB-Key. 
 

Replace the four alkaline batteries with new batteries of the same type. Refer to the 
"TIMY Time Reporting Terminal" manual, page 5, for more details. 

 



TIMY-Soft Application Software     Page 59 of 57 

Index 

A 
About the Time format  ...................................  27 
About the USB-Key  ........................................  37 
Absence and Corrections Management  .............  24 
Active Period  .................................................  16 
Advanced calculations  ................................ 43-48 
Anti-Virus programs  .......................................  54 
Audit trail  ...................................................... 19 

B 
Badge number  ........................................  14, 34 
Break with minimum deduction  .......................  43 

C 
Calculations, Customer-Specific  ..................  42-49 
Calendars, Delete  ..........................................  32 
Calendars, Extending  ...................................... 10 
Capping, Time  ...............................................  22  
Changing the PC  ............................................  54 
Clocking Errors  ........................................  11, 28 
Closing a Time Sheet  .....................................  27 
Column widths, set  ..................................  13, 43 
Columns, hiding/showing . ...............................  26  
Compact Old Data . ........................................  31 
Compatibility, TIMY-Soft and Microsoft  ...............  1 
Control Panel  ..................................  11,13,15-16 
Correction codes  ......................................  12, 25 

D 
Data Back-up .................................................. 36 
Delete calendar  .............................................  32 
Delete employee  ...........................................  15 
Delete Old Data  .............................................  31 
Displaying Time Sheets  ..................................  16 
Do's and Don'ts  .............................................  55 

E 
Employee Registration  ...............................  12-14  
Employee, delete  ...........................................  15 
Employee, modify  ..........................................  15 
Errors, search for  ..........................................  27 
Excel 2007, 2010, 2013 Applications  ..................  8 
Excel macro settings  .....................................  1-3 
Excel Rounding and Truncating  ........................  51 
Exit TIMY-Soft  ...............................................  38 
Export reports  ...............................................  30 
Extending Calendars  ......................................  10 

F 
Format, About the Time  ..................................  25 
Formatting the USB-Key  ............................  39-41 
Frequently Asked Questions  ............................  56 

G 
Get Clocking Data  ................................ 10, 32, 34 

H 
Hiding Columns  .............................................  26 

I 
ID-Badge, Replacing  ......................................  35 
Importing Time Stamps  .............................  32-34 
INIT USB procedure  ..................................  39-40 
Installation Overview  .......................................  1 
Installing TIMY-Soft files  ................................  4-6 

M 
Macro protection, deactivate  ..........................  1-3 
Manual entry, Time Stamps  ............................  17 
Midday break, calculation ................................  43 
Midnight, straddling  .......................................  22 
Midnight hours, automatic correction  ...............  24 
Midnight hours, manual correction  ...................  23 
Minimum deduction, Midday Break  ..............  43-44 
Modify, Employee  ..........................................  15 
Modifying Time Sheets  ...................................  17 
Modifying Time Stamps, Audit trail  ...................  19 

N 
New Employee  .......................................... 13-14 
New Records  ...........................................  11, 34 
Night Work, calculation  .............................  47-49 

O 
Overtime, calculation  ................................  46-47 

P 
Password protection  ........................................ 12 
PC Calendar Settings, Verification  ....................... 1 
PC Desktop shortcut  ........................................  6 
Planning mode, calendars  ...............................  11 
Print Time Sheets  ................................  12, 28-29 
Problem resolution  ....................................  52-54 
Protection, deactivate macro  ..........................  1-3 

R 
Receipt of Time Stamps from a Remote Site  ...... 41 
Registration, Employee  ..............................  12-14 
Removing 'seconds'  from new Time Stamps ..... 11 
Replacing a Lost ID-Badge  ............................... 35 
Reports, export  .............................................. 30 
Restore Time Stamp Data  ..........................  36-38 
Rounding and Truncating in Excel  ..................... 51 

S 
Search for Errors  ...........................................  27 
Settings, Excel  ................................................  2 
Settings, PC  ....................................................  1 
Shortcut, creating  ............................................  6 
Show Summary  ........................................ 11, 30 
Starting and Using TIMY-Soft  ............................  7 
Straddling Midnight  ......................................... 22 
Summary report  ....................................... 11, 30  

T 
Technical Supplement  ..................................... 39 
Terminate and Exit from TIMY-Soft  ................... 38 
Time calculations  ....................................... 19-21 
Time capping . ................................................ 22 
Time format, About  ....................................  1, 27 
Time format, hours and minutes  ....................... 49 
Time Models ................................................... 19 
Time Sheets Back-up  ...................................... 36 
Time Sheet, closing  ........................................ 27 
Time Sheet contents  ....................................... 17 
Time Sheets, Audit trail . .................................. 19 
Time Sheets, Displaying  .................................. 16 
Time Sheets, Modifying  ................................... 17 
Time Sheets, Print  ....................................  28-29 
Time Sheets, Show Summary  .......................... 30 
Time Stamps, Receipt from a Remote Site  ......... 41 
Time Stamps, importing  ............................  32-34 
Time Stamps, manual entry  ............................. 17 
TIMY-Soft, Excel format reversion  ....................... 9 
TIMY-Soft, Starting and Using  ............................ 7 
TIMY-Soft, Terminate and Exit  .......................... 38 
TIMY-Soft Worksheet descriptions  ..................... 11 

U 
USB-Key, Formatting  ................................  39-40 
USB-Key, Importing Time Stamps  .......... 32, 34-35 
Using TIMY-Soft ................................................ 7 

W 
Worksheet descriptions, TIMY-Soft  ............... 11-12



 

Time Attendance Systems 
 T-Data Limited 

Tel: (+44) 0118.979.5070 ▪ Fax: (+44) 0709.231.2381 
e-mail: sales@t-data.co.uk ▪ www.t-data.co.uk 


	Verification of PC Calendar Settings
	Installing on a PC with Windows®98

	Excel macro settings for TIMY-Soft
	Installing TIMY-Soft Files
	PC Desktop shortcut
	Starting and Using TIMY-Soft
	Excel 2007, 2010, 2013 Applications
	TIMY-Soft "xlsm" format reversion to "xls"
	Extending Calendars
	Follow the instructions and then select
	"Get Clocking Data" again.
	Planning Mode

	Removing 'seconds' from new Time Stamps
	TIMY-Soft worksheet descriptions
	Employee Registration
	Modify Employee
	Delete Employee
	Displaying Time Sheets
	Time Sheet Contents
	Modifying Time Sheets

	Audit Trail after Modifying Time Sheets
	Time Capping
	Straddling Midnight
	Allow sufficient buffer time in the value of cell B6 in case of late "clock-out" due to overtime requirements. If, for example, the time is set as 07:30, but the employee "clocks-out" at 08:30, the automatic "Midnight X-Over" cannot occur and a manual...
	The automatic "Midnight X-Over" action cannot be retro-actively applied to Time Stamps that already exist in any Time Sheets. It is only applied to Time Stamps when they are imported from the data file on the USB-Key or "New Records".

	Absence and Corrections Management
	Correction Codes
	Hiding Columns
	About the Time format
	Closing a Time Sheet
	Search for Errors
	Print Time Sheets

	Export Print Time Sheets report
	Show Summary
	Export Summary report
	Compact or delete old data
	Importing Time Stamps from the USB-Key
	New Records
	Replacing a Lost ID-Badge
	Data Back-up

	Time Sheets Back-up (from version 1.58)
	Restore Time Stamp Data (from version 1.58)
	In the event of PC crashes where time stamp data may have been lost or corrupted, it is now possible to easily restore previously backed-up time stamps from the Timy-Soft 'history' files, effective from version v.158 onwards.
	1. In the "Employee List" screen, select the name of the Employee that you wish to apply restored data, in our example Peter REEVES, and in the "Control Panel" chose "Modify Employee".
	2.  When                        is selected an information message is displayed. If 'Yes' is chosen, all Time Stamps will be imported from any available Timy-Soft 'history' files and saved into the "New Records" tab.
	3. If 'No' is selected the restore function is cancelled
	and the "Modify Employee" menu is removed.
	4. When completed, the restore function will display the message on the right.
	5. Select 'OK' to clear the message, returning control to the "Employee List" display.
	6. When all data has been recovered, select the tab "New Records" at the bottom of the "Employee List" and observe information similar to the image below:
	7. The data is likely to be much more than is required to correct errors on the related Employee Time Sheets, and filtering must be made by selecting
	8. The filter menu opens, shown on the right, where dates to be deleted can be chosen, leaving only the time stamp data that is required to restore the Employee Time Sheet(s).
	9. Select "Go!" when dates have been entered. If NO dates are entered a warning message will be displayed.
	10. A confirmation message will be displayed when valid dates have been entered and "Go!" is selected. Select 'Yes' to proceed.
	11. The restored data for the remaining dates will remain in the "New Records" display.
	12. Return to the "Employee List", ensure the TIMY USB-Key is NOT connected and select "Get Clocking Data" on the "Control Panel".
	13. The message on the right will be displayed.
	Select 'Yes' to proceed.
	14. After importing time stamps from the "New Records" the following message might be displayed if Timy-Soft detects that identical Time Stamps already exist in Employee Time Sheets.
	15. If the message in step 14 is displayed return to the "New Records" tab and repeat steps 8-10 for all the dates displayed to remove redundant data from the file.
	NOTE: The time stamp data restore function can only be applied to individual Employee Time Sheets, via the Control Panel "Modify Employee" function. It cannot be applied to all Employee Time Sheets in a batch mode.
	Terminate and Exit from TIMY-Soft
	About the USB-Key
	Format the USB-Key on the Time Recorder
	Format the USB-Key on the PC
	Receipt of Time Stamps from a Remote Site
	Customer-Specific calculations

	Calculation 1: Midday break with minimum deduction
	Time format in Hours and Minutes
	Rounding and Truncating in Excel
	Problem resolution
	Changing the PC
	Do’s and Don’ts
	Frequently Asked Questions
	Index
	e-mail: sales@t-data.co.uk ▪ www.t-data.co.uk

